User’s Manual for
Standard TEMPpoint, VOLTpoint,
and MEASURpoint LXI
Instruments

DT8871, DT8871U, DT8872, DT8873, DT8874
Trademark and Copyright Information


Other product and company names mentioned herein are trademarks or trade names of their respective companies.

© 2018 Measurement Computing Corporation. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form by any means, electronic, mechanical, by photocopying, recording, or otherwise without the prior written permission of Measurement Computing Corporation.

Notice

Measurement Computing Corporation does not authorize any Measurement Computing Corporation product for use in life support systems and/or devices without prior written consent from Measurement Computing Corporation. Life support devices/systems are devices or systems that, a) are intended for surgical implantation into the body, or b) support or sustain life and whose failure to perform can be reasonably expected to result in injury. Measurement Computing Corporation products are not designed with the components required, and are not subject to the testing required to ensure a level of reliability suitable for the treatment and diagnosis of people.
Radio and Television Interference

This equipment has been tested and found to comply with CISPR EN55011 Class A and EN61326-1 requirements and also with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his own expense.

Changes or modifications to this equipment not expressly approved by Data Translation could void your authority to operate the equipment under Part 15 of the FCC Rules.

---

**Note:** This product was verified to meet FCC requirements under test conditions that included use of shielded cables and connectors between system components. It is important that you use shielded cables and connectors to reduce the possibility of causing interference to radio, television, and other electronic devices.

---

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la class A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.
# Table of Contents

**About this Manual** ................................................................. 9
  Intended Audience ................................................................. 9
  How this Manual is Organized .................................................. 10
  Conventions Used in this Manual ............................................. 10
  Related Information ............................................................... 11
  Where To Get Help ................................................................. 11

**Chapter 1: Overview** ........................................................... 13
  Hardware Features ................................................................. 14
    TEMPtrpoint Features .......................................................... 14
    VOLTpoint Features ............................................................. 16
    MEASURpoint Features ........................................................ 17
  Supported Software ............................................................... 19
  Accessories .............................................................................. 22
  Getting Started Procedure ...................................................... 23

**Part 1: Getting Started** .......................................................... 25

**Chapter 2: Preparing to Use the Instrument** .................................. 27
  Unpacking ................................................................................. 29
  Checking the System Requirements ........................................... 30
  Installing the Software .............................................................. 31
    Prerequisite Software .......................................................... 31
    Installation Instructions ......................................................... 31
  Viewing the Documentation ...................................................... 32

**Chapter 3: Setting Up and Installing the Instrument** ............................ 33
  Connecting the Instrument to the LAN ....................................... 35
    Connecting to a Site LAN ....................................................... 36
    Connecting to a Private LAN .................................................. 37
      Connecting Using a Hub or Switch ........................................ 37
      Connecting Directly to a Computer ..................................... 38
  Applying Power ......................................................................... 39
  Getting an IP Address and Host Name ....................................... 41
  Determining Ethernet Activity .................................................. 42
  Resetting the Instrument ......................................................... 44

**Chapter 4: Wiring Signals** .......................................................... 45
  General Wiring Recommendations ............................................. 47
Warm-Up Time ................................................................. 48
Connecting Thermocouple Inputs ........................................ 49
Connecting RTD Inputs ....................................................... 51
  4-Wire RTD Connections .............................................. 52
  3-Wire RTD Connections .............................................. 53
  2-Wire RTD Connections .............................................. 53
Connecting Voltage Inputs ................................................ 55
  Connecting Voltage Inputs to Thermocouple Channels .......... 55
  Connecting Voltage Inputs to RTD Channels ...................... 57
  Connecting Voltage Inputs to Voltage Channels ................. 58
Connecting Current Loop Inputs ........................................ 60
  Connecting Current Loop Inputs to Thermocouple Channels ... 60
  Connecting Current Loop Inputs to RTD Channels ............... 62
  Connecting Current Loop Inputs to Voltage Channels .......... 63
Connecting Digital I/O Signals ........................................... 64
  Connecting Digital Input Signals .................................... 65
  Connecting Digital Output Signals .................................. 66

Chapter 5: Configuring the Instrument
Using the Web Interface ................................................... 67
Before Using the Web Interface .......................................... 69
  Java Requirements ...................................................... 69
  Internet Explorer Browser Settings .................................. 69
    JavaScript ............................................................. 70
    Security Levels ...................................................... 70
      Internet Zone ....................................................... 70
      Local Intranet Zone .............................................. 71
      Trusted Sites Zone .............................................. 72
  Pop-up Blockers ....................................................... 73
  Associating CSV Files with Microsoft Excel or Notepad ......... 74
Locating Your Instrument on the LAN .................................. 75
  Running the Eureka Discovery Utility ............................... 75
  Configuring Windows Firewall Settings ............................. 76
  Launching the Web Interface ........................................ 78
Configuring the Instrument ............................................... 79
  LAN Configuration ..................................................... 79
  Channel Configuration ............................................... 80
  Scan Rate .............................................................. 82
  Filter Configuration .................................................. 83
  Alarm Limits Configuration .......................................... 84
  Digital Input and Trigger Configuration ............................ 85
  Digital Output Configuration ........................................ 86
Measuring Data and Controlling the Instrument .................................................. 87
Starting and Stopping a Scan ................................................................. 87
Controlling the Digital Outputs ............................................................... 88
Reading the Digital Inputs ......................................................................... 90
Downloading Measurements .................................................................... 91

Part 2: Using Your Instrument ................................................................. 93

Chapter 6: Principles of Operation ......................................................... 95
Block Diagrams .......................................................................................... 96
  DT8871U Block Diagram ........................................................................ 96
  DT8871 Block Diagram .......................................................................... 97
  DT8872 Block Diagram .......................................................................... 98
  DT8873 Block Diagram .......................................................................... 99
  DT8874 Block Diagram .......................................................................... 100
Analog Input Features ................................................................................ 101
  Analog Input Channels ........................................................................... 101
    Thermocouple Input Channels ............................................................. 102
    Cold Junction Compensation ............................................................. 103
    Open Thermocouple Detection ............................................................ 103
    RTD Channels ..................................................................................... 104
Input Ranges ............................................................................................... 104
  Out of Range Data for Thermocouple Channels ........................................ 105
  Out of Range Data for RTD Channels ...................................................... 106
  Out of Range Data for Voltage Channels ................................................ 106
Resolution ................................................................................................... 106
Calibration .................................................................................................... 106
Sample Clock Source ................................................................................. 107
Trigger Source ............................................................................................ 107
Conversion Modes ....................................................................................... 108
  Simultaneous Single-Value Operations ................................................... 108
  Continuous Scan Mode ........................................................................... 108
    Specifying Analog Input Channels ...................................................... 108
    How Continuous Scan Works ............................................................. 109
Filtering ....................................................................................................... 110
Data Format ................................................................................................ 110
  Data Format for Thermocouple Channels ................................................. 110
  Data Format for RTD Channels ............................................................... 110
  Data Format for Voltage Channels ........................................................ 111
Error Conditions ........................................................................................ 111
Digital I/O Features ..................................................................................... 112
**About this Manual**

TEMPpoint is a family of temperature measurement instruments that includes the DT9871, DT9871U, DT8871, DT8871U, DT9872, and DT8872. This manual describes the DT8871, DT8871U, and DT8872 Ethernet LXI (LAN eXtensions for Instrumentation) models.

VOLTpoint is a family of voltage measurement instruments that includes the DT9873 and DT8873. This manual describes the DT8873 LXI model.

MEASURpoint™ a family of mixed temperature and voltage measurement instruments that includes the DT9874 and DT8874. This manual describes the DT8874 LXI model.

---

**Note:** For information on the DT9871, DT9871U, DT9872, DT9873, and DT9874 USB models of TEMPpoint, VOLTpoint, and MEASURpoint, refer to the *User’s Manual for Standard TEMPpoint, VOLTpoint, and MEASURpoint USB Instruments.*

---

The first part of this manual describes how to install and set up your instrument, and verify that the instrument is working properly.

The second part of this manual describes the features and capabilities of your instrument using the IVI-COM instrument driver software. Troubleshooting information is also provided.

---

**Note:** If you are programming the instrument using the IVI-COM driver, refer to the DtxMeasurement IVI-COM driver online help for more information.

If you are using Standard Commands for Programmable Instruments (SCPI) to program your instrument, refer to the *SCPI Programmer’s Manual for MEASURpoint* for more information.

---

**Intended Audience**

This document is intended for engineers, scientists, technicians, or others responsible for using and/or programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument. It is assumed that you have some familiarity with thermocouples, RTDs, and/or voltages and that you understand your application.
How this Manual is Organized

This manual is organized as follows:

- Chapter 1, “Overview,” summarizes the major features of the TEMPpoint, VOLTpoint, and MEASURpoint instruments, as well as the supported software and accessories.
- Chapter 2, “Preparing to Use the Instrument,” describes how to unpack the instrument, check the system requirements, install the software, and view the documentation online.
- Chapter 3, “Setting Up and Installing the Instrument,” describes how to apply power to the instrument and connect the instrument to the network.
- Chapter 4, “Wiring Signals,” describes how to wire signals to the instrument.
- Chapter 5, “Configuring the Instrument Using the Web Interface,” describes how to configure the instrument using the instrument’s web interface.
- Chapter 6, “Principles of Operation,” describes the analog input and digital I/O features of the TEMPpoint, VOLTpoint, and MEASURpoint instruments in detail.
- Chapter 7, “Troubleshooting,” provides information that you can use to resolve problems with your instrument, should they occur.
- Appendix A, “Specifications,” lists the specifications of the TEMPpoint, VOLTpoint, and MEASURpoint instruments.
- Appendix B, “Connector Pin Assignments,” describes the pin assignments of the digital I/O connector on the TEMPpoint, VOLTpoint, and MEASURpoint instruments.
- Appendix C, “Configuring Network Settings on Your PC,” describes how to configure the network settings of your PC to use Auto-IP or a static IP address.
- An index completes this manual.

Conventions Used in this Manual

The following conventions are used in this manual:

- Notes provide useful information or information that requires special emphasis, cautions provide information to help you avoid losing data or damaging your equipment, and warnings provide information to help you avoid catastrophic damage to yourself or your equipment.
- Items that you select or type are shown in bold.
- CAUTION – This icon denotes a caution, which advises you to consult the documentation where this symbol is marked.

CAUTION – Do not operate this product in a manner not specified in this document. Product misuse can result in a hazard. You can compromise the safety protection built into the product if the product is damaged in any way.
Related Information

Refer to the following documents for more information on using a TEMPpoint, VOLTpoint, or MEASURpoint LXI instrument:

- DtxMeasurement IVI-COM Driver online help. This document describes how to use the IVI-COM driver to access the capabilities of your instrument.
  The IVI-COM driver works with any development environment that supports COM programming, including MATLAB® from The MathWorks™, Microsoft® Visual C#®.NET or Visual Basic®.NET, Agilent® VEE Pro, National Instruments™ LabVIEW™ or LabWindows™, and so on.

- QuickDAQ User’s Manual (UM-25242). This manual describes how to create a QuickDAQ application to acquire and analyze data from a TEMPpoint, VOLTpoint, or MEASURpoint instrument.

- SCPI Programmer’s Manual for LXI Measurement Instruments. For programmers who want to use the SCPI interface to program a TEMPpoint, VOLTpoint, or MEASURpoint instrument, this document describes the supported SCPI commands and example programs for these instruments.

- IVI foundation (www.ivifoundation.org)

- Omega Complete Temperature Measurement Handbook and Encyclopedia® or the Omega Engineering web site: http://www.omega.com. Both resources provide valuable information on thermocouple types, RTD types, standards, and linearization.

Where To Get Help

Should you run into problems installing or using a TEMPpoint, VOLTpoint, or MEASURpoint instrument, the Data Translation Technical Support Department is available to provide technical assistance. Refer to Chapter 7 for more information. If you are outside the United States or Canada, call your local distributor, whose number is listed on our web site (www.mccdaq.com).
Overview

Hardware Features .......................................................... 14
Supported Software ......................................................... 19
Accessories ..................................................................... 22
Getting Started Procedure .............................................. 23
Hardware Features

Data Translation provides a number of LXI (Ethernet) instruments to meet your measurement needs, including the following:

- TEMPpoint – a family of temperature measurement instruments
- VOLTpoint – a family of voltage measurement instruments
- MEASURpoint – a family of mixed temperature and voltage measurement instruments

All of these Ethernet instruments are class C devices that comply with LXI version 1.1.

The following sections summarize the features of the TEMPpoint, VOLTpoint, and MEASURpoint LXI instruments.

TEMPpoint Features

TEMPpoint instruments include the following models: DT8871U, DT8871, and DT8872. Figure 1 shows a DT8871U instrument.

![Figure 1: TEMPpoint Instrument](image)

The key features of TEMPpoint instruments are as follows:

- **DT8871U and DT8871:**
  - Configurable analog input channels for thermocouple or differential voltage inputs; easy-access jacks for each channel for quick wiring
  - One CJC (cold junction compensation) input for each thermocouple channel
- B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically linearizes the measurements and returns the data as a 32-bit, floating-point temperature values
- Input range of ±0.075 V for the DT8871U (with 0.25 \( \mu \)V RMS A/D noise using no software filtering) and ±1.25 V for the DT8871 (with 5 \( \mu \)V RMS A/D noise using no software filtering)
- Break-detection circuitry to detect open thermocouple inputs

- **DT8872:**
  - Configurable analog input channels for RTDs and differential voltage inputs; easy-access jacks for each channel for quick wiring
  - 100 \( \Omega \), 500 \( \Omega \), and 1000 \( \Omega \) platinum RTD types supported using alpha curves of 0.00385 (European) or 0.00392 (American)
  - 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the measurements and returns the data as 32-bit, floating-point temperature, resistance, or voltage values
  - Input range of ±1.25 V

- One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution measurements
- Throughput rate of up to 10 Samples/s for all channels.
- Software or external, digital trigger on digital input line 0 starts acquisition
- Auto-calibrating front-end resets the zero point on each power-up; in addition, the instrument supports anytime calibration, performing an auto-calibration function on software command
- Measurement Instrument Calibration Utility allows you to calibrate the instrument in the field (see page 21 for more information on this utility)
- 8 opto-isolated digital input lines; you can read the digital input port through the analog input data stream for correlating analog and digital measurements
- 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from ±30 V at currents up to 400 mA (peak) AC or DC
VOLTpoint Features

Figure 2 shows a VOLTpoint instrument.

The key features of VOLTpoint (DT8873) instruments are as follows:

- Direct connection of analog input channels for differential voltage inputs; removable screw terminal blocks for each channel for quick wiring
- One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution measurements
- Software-selectable input range of ±10 V or ±60 V per channel (note that for the ±60 V range, no more than 30 Vrms, 42.4 Vpk, 60 VDC is allowed)
- Throughput rate of up to 10 Samples/s for all channels
- Software or external, digital trigger on digital input line 0 starts acquisition
- Auto-calibrating front-end resets the zero point on each power-up; in addition, the instrument supports anytime calibration, performing an auto-calibration function on software command
- Measurement Instrument Calibration Utility allows you to calibrate the instrument in the field (see page 21 for more information on this utility)
- 8 opto-isolated digital input lines; you can read the digital input port through the analog input data stream for correlating analog and digital measurements
- 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from ±30 V at currents up to 400 mA (peak) AC or DC
MEASURpoint Features

The standard MEASURpoint (DT8874) instrument provides 16 thermocouple channels, 16 RTD channels, and 16 voltage channels. Figure 3 shows a MEASURpoint instrument.

Figure 3: MEASURpoint Instrument

The key features of MEASURpoint (DT8874) instruments are as follows:

- **Analog Input Channels 0 to 15:**
  - Configurable channels for thermocouple or differential voltage inputs; easy-access jacks for each channel for quick wiring
  - One CJC (cold junction compensation) input for each thermocouple channel
  - B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically linearizes the measurements and returns the data as a 32-bit, floating-point temperature values
  - Input range of ±0.075 V (with 0.25 μV RMS A/D noise using no software filtering)
  - Break-detection circuitry to detect open thermocouple inputs
• Analog Input Channels 16 to 31:
  – Configurable analog input channels for RTDs and differential voltage inputs; easy-access jacks for each channel for quick wiring
  – 100 Ω, 500 Ω, and 1000 Ω platinum RTD types supported using alpha curves of 0.00385 (European) or 0.00392 (American)
  – 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the measurements and returns the data as 32-bit, floating-point temperature, resistance, or voltage values
  – Input range of ±1.25 V

• Analog Input Channels 31 to 48:
  – Direct connection of analog input channels for differential voltage inputs; removable screw terminal blocks for each channel for quick wiring
  – Software-selectable input range of ±10 V or ±60 V per channel (note that for the ±60 V range, no more than 30 Vrms, 42.4 Vpk, 60 VDC is allowed)

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution measurements

• 30 VAC, 60 VDC continuous functional isolation ch-ch and ch-gnd, verified by a 500 Vpk withstand

• Throughput rate of up to 10 Samples/s for all channels

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the instrument supports anytime calibration, performing an auto-calibration function on software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the field (see page 21 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from ±30 V at currents up to 400 mA (peak) AC or DC
Supported Software

The following software is available for use with the TEMPpoint, VOLTpoint, and MEASURpoint instruments:

- **Eureka Discovery Utility** – This utility helps you locate or "discover" all LXI (Ethernet) instruments that are connected to your system and provides the following information about your instrument: the IP address, manufacturer, model number, serial number, and version of the firmware that is running on your instrument. In addition, you can use this utility to configure Windows firewall settings and update the firmware for your Data Translation LXI instrument.

- **Instrument Web Interface** – This built-in interface, described in Chapter 5, allows you to verify the operation of your instrument and perform basic functions with Internet Explorer and no additional software. Using it, you can configure your instrument, control output signals, measure input signals, and save results to disk.

- **QuickDAQ Base Version** – The base version of QuickDAQ is free-of-charge and allows you to acquire and analyze data from all Data Translation USB and Ethernet devices, except the DT9841 Series, DT9817, DT9835, and DT9853/54. Using the base version of QuickDAQ, you can perform the following functions:
  - Discover and select your devices.
  - Configure all input channel settings for the attached sensors.
  - Load/save multiple hardware configurations.
  - Generate output stimuli (fixed waveforms, swept sine waves, or noise signals).
  - On each supported data acquisition device, acquire data from all channels supported in the input channel list.
  - Choose to acquire data continuously or for a specified duration.
  - Choose software or triggered acquisition.
  - Log acquired data to disk in an .hpf file.
  - Display acquired data during acquisition in either a digital display using the Channel Display window or as a waveform in the Channel Plot window.
  - Choose linear or logarithmic scaling for the horizontal and vertical axes.
  - View statistics about the acquired data, including the minimum, maximum, delta, and mean values and the standard deviation in the Statistics window.
  - Export time data to a .csv or .txt file; you can open the recorded data in Microsoft Excel® for further analysis.
  - Read a previously recorded .hpf data file.
  - Customize many aspects of the acquisition, display, and recording functions to suit your needs, including the acquisition duration, sampling frequency, trigger settings, filter type, and temperature units to use.
• **QuickDAQ FFT Analysis Option** – When enabled with a purchased license key, the QuickDAQ FFT Analysis option includes all the features of the QuickDAQ Base version plus basic FFT analysis features, including the following:
  - The ability to switch between the Data Logger time-based interface and the FFT Analyzer block/average-based interface.
  - Supports software, freerun, or triggered acquisition with accept and reject controls for impact testing applications.
  - Allows you to perform single-channel FFT (Fast Fourier Transform) operations, including AutoSpectrum, Spectrum, and Power Spectral Density, on the acquired analog input data. You can configure a number of parameters for the FFT, including the FFT size, windowing type, averaging type, integration type, and so on.
  - Allows you to display frequency-domain data as amplitude or phase.
  - Supports dB or linear scaling with RMS (root mean squared), peak, and peak-to-peak scaling options
  - Supports linear or exponential averaging with RMS, vector, and peak hold averaging options.
  - Supports windowed time channels.
  - Supports the following response window types: Hanning, Hamming, Bartlett, Blackman, Blackman Harris, and Flat top.
  - Supports the ability to lock the waveform output to the analysis frame time.
  - Allows you to configure and view dynamic performance statistics, including the input below full-scale (IBF), total harmonic distortion (THD), spurious free dynamic range (SFDR), signal-to-noise and distortion ratio (SINAD), signal-to-noise ratio (SNR), and the effective number of bits (ENOB), for selected time-domain channels in the Statistics window.
  - Supports digital IIR (infinite impulse response) filters.

• **QuickDAQ Advanced FFT Analysis Option** – When enabled with a purchased software license, the QuickDAQ Advanced FFT Analysis option includes all the features of the QuickDAQ Base version with the FFT Analysis option plus advanced FFT analysis features, including the following:
  - Allows you to designate a channel as a Reference or Response channel.
  - Allows you to perform two-channel FFT analysis functions, including Frequency Response Functions (Inertance, Mobility, Compliance, Apparent Mass, Impedance, Dynamic Stiffness, or custom FRF) with H1, H2, or H3 estimator types, Cross-Spectrum, Cross Power Spectral Density, Coherence, and Coherent Output Power.
  - Supports the Exponential response window type.
  - Supports the following reference window types: Hanning, Hamming, Bartlett, Blackman, Blackman Harris, FlatTop, Exponential, Force, and Cosine Taper windows.
  - Supports real, imaginary, and Nyquist display functions.
  - Allows you to save data in the .uff file format.
• **DtxMeasurement IVI-COM driver** – This driver provides access to the instrument’s functions through a COM server. The IVI-COM driver works in any 32- or 64-bit development environment that supports COM programming, including MATLAB, Visual Basic.NET, Visual C#.NET, Agilent VEE Pro, LabVIEW, LabWindows, and others.

• **SCPI commands** – Use SCPI commands to program TEMPpoint, VOLTpoint, or MEASURpoint LXI instruments. Refer to the *SCPI Programmer’s Manual for LXI Measurement Instruments* for information on the supported SCPI commands and example programs.

• **Measurement Instrument Calibration Utility** – Users can calibrate a TEMPpoint, VOLTpoint, or MEASURpoint instrument in the field using precise calibration equipment and the Measurement Instrument Calibration Utility. Since each instrument consists of up to 48 individual channels, great care must be taken to ensure that proper warm-up times are followed and precise calibration equipment is used.

  The calibration utility ships with a comprehensive help file that describes the required equipment and calibration procedure, including warm-up times, for each instrument.

  The calibration utility allows you to revert to the factory calibration for any or all channels, or revert back to the last user calibration values, if desired. In addition, this utility generates a report that lists the starting and ending calibration values for each channel, allowing traceability.

Refer to the Data Translation web site (www.mccdaq.com) for information about selecting the right software package for your needs.
Accessories

The following optional accessories are available for TEMPpoint, VOLTpoint, or MEASURpoint instruments:

- **STP37 screw terminal panel** – The STP37, shown in Figure 4, permits easy screw terminal connections for accessing the digital I/O signals of a TEMPpoint, VOLTpoint, or MEASURpoint instrument.

![Figure 4: STP37 Screw Terminal Panel](image)

- **EP333 cable** – The EP333, shown in Figure 5, is a 2-meter shielded cable with two 37-pin connectors that connects the STP37 screw terminal panel to the digital I/O connector of the instrument.

![Figure 5: EP333 Cable](image)

- **EP373 Single Rack-mount Kit** – Mounts one TEMPpoint, VOLTpoint, or MEASURpoint instrument in a rack.

- **EP374 Dual Rack-mount Kit** – Mounts two TEMPpoint, VOLTpoint, or MEASURpoint instruments side-by-side in a rack.
Getting Started Procedure

The flow diagram shown in Figure 6 illustrates the steps needed to get started using a TEMPpoint, VOLTpoint, or MEASURpoint instrument. This diagram is repeated in each Getting Started chapter; the shaded area in the diagram shows you where you are in the getting started procedure.

![Figure 6: Getting Started Flow Diagram](image-url)
Part 1: Getting Started
Preparing to Use the Instrument

Unpacking ................................................................. 29
Checking the System Requirements .............................. 30
Installing the Software ............................................... 31
Viewing the Documentation ....................................... 32
Prepare to Use the Instrument (this chapter)

Set Up and Install the Instrument (see Chapter 3 starting on page 33)

Wire Signals (see Chapter 4 starting on page 45)

Configuring the Instrument Using the Web Interface (see Chapter 5 starting on page 67)
Unpacking

Open the shipping box and verify that the following items are present:

- TEMPpoint, VOLTpoint, or MEASURpoint instrument
- EP372 Ethernet cable
- EP361 +5V power supply and cable
- For DT8872, DT8873, and DT8874 instruments, a bag of pluggable screw terminable blocks.

If an item is missing or damaged, contact Data Translation. If you are in the United States, call the Customer Service Department at 508-946-5100. An application engineer will guide you through the appropriate steps for replacing missing or damaged items. If you are located outside the United States, call your local distributor, listed on Data Translation’s web site (www.mccdaq.com).
Checking the System Requirements

For reliable operation, ensure that your computer meets the following system requirements:

- Processor: Pentium 4/M or equivalent
- RAM: 1 GB
- Screen Resolution: 1024 x 768 pixels
- Disk Space: 4 GB
- Ethernet port
- Administrator privileges for software installation
- For access to the instrument web interface:
  - Java Version 6, Update 5 or greater
  - Internet Explorer 6.0 or 7.0 web browser

Refer to page 69 for more information on installing Java and configuring your browser settings

- Acrobat Reader 5.0 or later for viewing documentation
Installing the Software

This section describes how to install the software you need to use your TEMPpoint, VOLTpoint, or MEASURpoint instrument.

Prerequisite Software

No prerequisite software is required if you are using a single client to access a TEMPpoint, VOLTpoint, or MEASURpoint instrument on the LXI bus, or if you are managing how multiple clients concurrently access the instrument on the LXI bus. (In these case, your application can use sockets to communicate with the instrument.)

If, however, you want multiple clients to access your instrument on the LXI bus, and you want to "lock" access to the instrument so that one client cannot change the configuration of the instrument that another client is accessing, you need to install VISA; we recommend either Agilent VISA or NI-VISA from National Instruments. You can then use the VISA methods viLock/viUnlock to prevent other clients from accessing the instrument.

To install Agilent VISA, do the following:

1. Go to www.agilent.com, enter IO Libraries Suite in the search field, and select Agilent IO Libraries Suite 15.0 from the search results.

2. Follow the instructions on Agilent’s web site to download and install the Agilent IO Libraries, which include VISA support, VISA COM support, and the Agilent Connection Expert tool.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with the MEASURpoint software to locate your LXI instrument on the network (see page 75 for more information).

Installation Instructions

Install the software for your instrument from the web at http://mccdaq.com/downloads/DTSOFTWARE/MEASURpoint.

The installation program guides you through the installation process.
Viewing the Documentation

Note: To view the documentation, you must have Adobe Reader 5.0 or greater installed on your system.

You can access the documentation for your instrument from the Windows Start menu as follows:

- For documentation about the TEMPpoint, VOLTpoint, or MEASURpoint instrument, click Programs -> Data Translation, Inc -> Hardware Documentation -> User’s Manual for Standard TEMPoint, VOLTpoint, and MEASURpoint LXI Instruments.
- For documentation on the Eureka Discovery Utility, click Programs -> Data Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.
- For documentation on the QuickDAQ application, click Programs -> Data Translation, Inc -> QuickDAQ -> QuickDAQ User’s Manual.
- For documentation on the DtxMeasurement IVI-COM driver, click Programs -> Data Translation, Inc -> DtxMeasurement -> DtxMeasurement IVI Driver 1.1.8 Documentation.
- For documentation about SCPI support, click Programs -> Data Translation, Inc -> Measurement SCPI Support -> SCPI Programmer’s Manual for Measurement.

The following may be helpful when using Adobe Reader:

- To navigate to a specific section of the document, click a heading from the table of contents on the left side of the document.
- Within the document, click the text shown in blue to jump to the appropriate reference (the pointer changes from a hand to an index finger).
- To go back to the page from which the jump was made, click the right mouse button and Go Back, or from the main menu, click Document, and then Go Back.
- To increase or decrease the size of the displayed document, from the main menu, click View, and then Zoom.
- By default, Adobe Reader smooths text and monochrome images, sometimes resulting in blurry images. If you wish, you can turn smoothing off by clicking File, and then Preferences/General, and unchecking Smooth Text and Images.
Setting Up and Installing the Instrument

Connecting the Instrument to the LAN .................................................. 35
Applying Power .................................................................................. 39
Getting an IP Address and Host Name .............................................. 41
Determining Ethernet Activity ........................................................... 42
Resetting the Instrument .................................................................. 44
Note: Your TEMPpoint, VOLTpoint, and MEASURpoint instruments are factory-calibrated. Thereafter, yearly recalibration is recommended. Refer to page 106 for more information on calibration.
Connecting the Instrument to the LAN

Figure 7 shows the LAN (RJ45) connector on the rear of the instrument that is used to connect your instrument to the LAN (Local Area Network).

This section describes how to connect your instrument to the LAN. Two connection schemes are shown:

- Site LAN connections, described on page 36
- Private LAN connections, described on page 37

Note: It is recommended that you consult with your network administrator to ensure that all network security, performance, and reliability issues are considered when using connecting instruments to the LAN.
Connecting to a Site LAN

A site LAN is useful in applications that require access by many users or access by users at distributed sites. In this connection scheme, a DHCP (Dynamic Host Configuration Protocol) server is used to assign an IP address to the instrument.

Figure 8 shows a typical site LAN connections using a dedicated Ethernet hub, switch, or router. Figure 9 shows typical site LAN connections without using a dedicated Ethernet hub, switch, or router.

---

**Note:** Use standard LAN cables for network connections. TEMPpoint, VOLTpoin, and MEASURpoint instruments ship with a standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear panel of the instrument.

---

![Figure 8: Typical Site LAN Connections using a Hub, Switch, or Router](image-url)
Connecting to a Private LAN

A private LAN (or subnet) generally involves the direct connection of the instruments to the computer, and may include Ethernet hubs or switches. Access to the instruments is limited to users that are directly connected to the private LAN; therefore, security, performance, and reliability are generally better on a private LAN than on a site LAN.

In this connection scheme, the DHCP (Dynamic Host Configuration Protocol) server is typically not available; therefore, Auto-IP is used to assign an IP address to the instrument.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must temporarily reconfigure your PC to use Auto-IP, as described on Appendix C starting on page 145.

Connecting Using a Hub or Switch

Figure 10 shows a typical connection scheme when connecting TEMPpoint, VOLTpoint, or MEASURpoint instruments to a private LAN using a dedicated Ethernet hub or switch.

Note: Use standard LAN cables for network connections. The instrument ships with a standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear panel of the instrument.
Connecting Directly to a Computer

Optionally, you can connect the TEMPpoint, VOLTpoint, or MEASURpoint instrument directly to your computer, creating an ad hoc network, as shown in Figure 11. Be aware that the time and date settings of the instrument will not be updated using this connection method. Therefore, this connection scheme is generally recommended for quick set up and verification only.

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments do not support the Auto-MDIX function; therefore, use a crossover cable rather than a standard LAN cable to connect your instrument unless your computer has enabled the Auto-MDIX function.
Applying Power

TEMPpoint, VOLTpoint, and MEASURpoint instruments are shipped with an EP361 +5V power supply and cable. To apply power to the instrument, do the following:

1. Connect the +5 V power supply to the power connector on the rear panel of the instrument. Refer to Figure 12.

![Figure 12: Attaching a +5 V Power Supply to the Instrument](image)

2. Plug the power supply into a wall outlet.

Note: For proper grounding of your measurement instrument, ensure that you use the power supply and cable (EP361) that is provided with the instrument and that you use all three prongs of the cable when connecting it to your wall outlet.

3. Press the Power switch on the rear panel of the instrument, shown in Figure 12, to turn on the instrument.

*The Power LED on the front panel lights to indicate that power is on.*
Figure 13 shows the location of the LEDs on the front panel of the instrument; a MEASURpoint instrument is shown in this example.

Figure 13: LEDs on the Front Panel of the Instrument
Getting an IP Address and Host Name

Once your instrument is connected to the LAN and powered on, the instrument automatically requests an Ethernet address from a DHCP (Dynamic Host Configuration Protocol) server, if available, and a host name from a DNS (Dynamic Domain Name Service) server, if available.

If these services are not available on the LAN, the instrument uses Auto-IP to set up its TCP/IP configuration. In this case, the IP address is in the range of 169.254.0.0 to 169.254.255.255 with a subnet mask of 255.255.0.0.

**Note:** If no DHCP server exists and your PC is set up to use a static IP address, you must temporarily reconfigure your PC to use Auto-IP, then configure your instrument to use a static IP address, as described in Appendix C starting on page 145.

You can use the instrument’s web interface, described in Chapter 5 starting on page 67, to see the IP address and host name that is assigned to your instrument.

**Notes:** When programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument, you access the instrument through its address string, which consists of an IP address or host name, such as `TCP0::192.43.218.69::inst0::INSTR` or `TCP0::192.43.218.69::SOCKET`. If a host name was returned by the DNS server, you can also address the instrument using its host name, such as `TCP0::arrakis.datx.com::inst0::INSTR`.

For IVI-COM programmers, you can also assign a VISA alias to the instrument. For example, rather than addressing the instrument as `TCP0::192.43.218.69::inst0::INSTR`, you can a VISA alias, such as `TEMPpoint1`, instead. See your VISA documentation for more information on VISA resource strings and creating VISA aliases.
Determining Ethernet Activity

You can use the ENet Link and ENet Activity LEDs on the rear of the instrument, shown in Figure 14, with the LAN LED on the front of the instrument, shown in Figure 13, to determine the Ethernet activity on your instrument. Table 1 describes the meaning of these LEDs.

![Figure 14: Rear Panel of the Instrument](image)

Table 1: Using LEDs to Determine Ethernet Activity

<table>
<thead>
<tr>
<th>LEDs</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN LED (on front panel)</td>
<td>Solid Green</td>
<td>Instrument has valid IP address.</td>
</tr>
<tr>
<td></td>
<td>Blinking Green</td>
<td>Instrument identified using the Web interface; see page 75 for more information.</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>If the Ethernet link is operational, the instrument does not have a valid IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Otherwise, the Ethernet link is not operational.</td>
</tr>
</tbody>
</table>
### Table 1: Using LEDs to Determine Ethernet Activity (cont.)

<table>
<thead>
<tr>
<th>LEDs</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENet Link LED</td>
<td>Yellow</td>
<td>Ethernet link operational.</td>
</tr>
<tr>
<td>(on rear panel)</td>
<td>Off</td>
<td>Ethernet link not operational.</td>
</tr>
<tr>
<td>ENet Activity LED</td>
<td>Green</td>
<td>Network traffic detected.</td>
</tr>
<tr>
<td>(on rear panel)</td>
<td>Off</td>
<td>No network traffic detected.</td>
</tr>
</tbody>
</table>
Chapter 3

Resetting the Instrument

If needed, you can restore the default configuration of your instrument by pressing the Reset pin on the rear panel of the instrument, shown in Figure 14 on page 42, until the LAN LED on the front panel turns off (which takes approximately 5 seconds), and then releasing the Reset pin.

The instrument reboots automatically using the factory-default LAN configuration (DHCP and auto-IP enabled); this process typically takes up to 40 seconds to complete. This forces the instrument to re-acquire an IP address from the DHCP server, or if that fails, to use Auto-IP to get an IP address.

Note: The default configuration overwrites any changes that you have made to the LAN configuration (IP address and password) using the instrument’s web interface. Refer to page 79 for information on the default values that are used when the instrument is reset.

The calibration parameters are not affected by the reset.
Wiring Signals

General Wiring Recommendations .................................................. 47
Warm-Up Time ................................................................................. 48
Connecting Thermocouple Inputs .................................................... 49
Connecting RTD Inputs ................................................................. 51
Connecting Voltage Inputs ............................................................. 55
Connecting Current Loop Inputs ..................................................... 60
Connecting Digital I/O Signals ....................................................... 64
Prepare to Use the Instrument
(see Chapter 2 starting on page 27)

Set Up and Install the Instrument
(see Chapter 3 starting on page 33)

Wire Signals
(this chapter)

Configuring the Instrument Using the Web
Interface (see Chapter 5 starting on page 67)
General Wiring Recommendations

Keep the following recommendations in mind when wiring signals to a TEMPPpoint, VOLTpoint, or MEASURpoint instrument:

- Separate power and signal lines by using physically different wiring paths or conduits.
- To avoid noise, do not locate the instrument and cabling next to sources that produce high electromagnetic fields, such as large electric motors, power lines, solenoids, and electric arcs, unless the signals are enclosed in a mumetal shield.
- Locate the instrument’s front panel as far away as possible from sources of high or low temperatures or strong air currents, such as fans.
- Prevent electrostatic discharge to the I/O while the instrument is operational.
- When wiring thermocouples, select an appropriate wire length and gauge for each thermocouple; in general, use the shortest wire length and largest gauge for the application to yield best results.
- Use shielded wire for maximum rejection of electrical interference.
Warm-Up Time

For accurate thermocouple measurements, MEASURpoint instruments require a warm-up time of 1 hour for the analog circuitry to stabilize.

For accurate RTD measurements, ensure that your RTD sensors and external calibration resistors warm up for 1 minute after the MEASURpoint instrument has been warmed up for 1 hour.
Connecting Thermocouple Inputs

The DT8871U, DT8871, and DT8874 instruments contain thermocouple jacks for connecting thermocouple inputs.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple input channels.

Internally, these signals are connected in differential mode. You can mix and match the following thermocouple types across channels: B, E, J, K, N, R, S, and/or T.

Each thermocouple input jack is polarized and accepts a mating plug in the appropriate orientation. Table 2 lists the color designations for the + and – polarities of the supported thermocouple types for both the ANSI (American) and IEC (International) standards.

Table 2: Thermocouple Color Designation Standards

<table>
<thead>
<tr>
<th>Thermocouple Standard</th>
<th>Thermocouple Type</th>
<th>Wire Color Coding + Polarity</th>
<th>Wire Color Coding – Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI</td>
<td>Type J</td>
<td>White</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type K</td>
<td>Yellow</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type T</td>
<td>Blue</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type E</td>
<td>Violet</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type S</td>
<td>Black</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type R</td>
<td>Black</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type B</td>
<td>Gray</td>
<td>Red</td>
</tr>
<tr>
<td></td>
<td>Type N</td>
<td>Orange</td>
<td>Red</td>
</tr>
<tr>
<td>IEC</td>
<td>Type J</td>
<td>Black</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type K</td>
<td>Green</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type T</td>
<td>Brown</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type E</td>
<td>Violet</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type S</td>
<td>Orange</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type R</td>
<td>Orange</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type B</td>
<td>Gray</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>Type N</td>
<td>Pink</td>
<td>White</td>
</tr>
</tbody>
</table>

For more information on thermocouple standards, refer to the following web site: http://www.omega.com/thermocouples.html.
CAUTION:

When connecting inputs to the thermocouple connectors on a MEASURpoint or TEMPpoint instrument, it is highly recommended that you use only original Omega thermocouple plugs (SMPW), as connectors from other suppliers may not be equivalent mechanically. Refer to page 138 for more information on the connectors.

If you use connectors from suppliers other than Omega, there is a risk that you may mechanically damage the thermocouple connectors on the MEASURpoint or TEMPpoint instrument.

Figure 15 shows how to connect a thermocouple input to a thermocouple channel.
Connecting RTD Inputs

Each DT8872 and DT8874 contains pluggable screw terminals for connecting RTD inputs. Internally, these signals are connected in differential mode.

**Note:** On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input channels.

Figure 16 shows the numbering of the screw terminal blocks for RTD connections.
The DT8872 supplies each RTD channel with 425 \( \mu \text{A} \) of excitation current to prevent self-heating. The resistance of the RTD circuit increases gradually, repeatably, and linearly with temperature. As the resistance increases, the voltage drop across the RTD also increases. The DT8872 reads this voltage drop and automatically converts the voltage to the appropriate temperature based on the RTD type.

The DT8872 and DT8874 support Pt100 (100 \( \Omega \) Platinum), Pt500 (500 \( \Omega \) Platinum), and Pt1000 (1000 \( \Omega \) Platinum) RTD types using Alpha coefficients of 0.00385 and 0.00392; you can mix and match RTD types across RTD channels. Refer to the following web site for more information on RTD types: http://www.omega.com.

To connect an RTD input, you can use a 4-wire, 3-wire, or 2-wire connection scheme, described in the following subsections. For the best accuracy, use 4-wire RTD connections; this connection scheme enables Kelvin sensing to minimize errors due to lead wire resistance.

### 4-Wire RTD Connections

The 4-wire configuration offers the best accuracy with long connection wires, compared to the 3- and 2-wire configurations. The 4-wire connection scheme eliminates errors due to lead wire resistance (\( R_L \)) and thermal heating. Wire impedance of up to 100 \( \Omega \) anywhere in the hookup is automatically cancelled as long as the sense wires are connected.

Figure 17 shows a 4-wire RTD connection.
3-Wire RTD Connections

The 3-wire configuration eliminates one wire from the 4-wire RTD connection. Lead wire resistance ($R_L$) errors in the return wire from \(-\text{Sense}\) may be introduced unless the voltage drop is essentially equal and opposite to the voltage drop across \(+\text{Sense}\).

Figure 18 shows a 3-wire RTD connection.

![3-Wire RTD Connection Diagram]

*Figure 18: 3-Wire RTD Connection*

2-Wire RTD Connections

The 2-wire configuration is the least accurate of the RTD wiring configurations because the lead wire resistance ($R_L$) and its variation with temperature contribute significant measurement errors, particularly if the lead wire is long. If you decide to use the 2-wire connection scheme, ensure that you use short lead wire connections.

For example, if the lead resistance is 0.5 $\Omega$ in each wire, the lead resistance adds a 1 $\Omega$ of error to the resistance measurement. Using a 100 $\Omega$ RTD (Pt100) with a 0.00385/°C European curve coefficient, the resistance represents an initial error of 1 $\Omega$ /\((0.385\,\text{°C})\) or 2.6°C. Since the lead wire resistance changes with ambient temperature, additional errors are also introduced in the measurement.
Figure 19 shows a 2-wire RTD connection.
Connecting Voltage Inputs

The way you connect voltage inputs depends on the channel type you are using. This section describes how to connect voltage inputs to thermocouple input channels, RTD input channels, and voltage input channels.

Connecting Voltage Inputs to Thermocouple Channels

Figure 20 shows how to connect a differential voltage input to a thermocouple input channel on the DT8871U, DT8871, or DT8874 instrument.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple input channels.
Figure 20: Connecting Voltage Inputs to a Thermocouple Channel
Connecting Voltage Inputs to RTD Channels

Figure 21 shows how to connect a voltage input to an RTD channel on a DT8872 or DT8874 instrument.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input channels.

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs.

For best accuracy when connecting voltage inputs, use twisted-pair wires with a dead-ended shield connected to pin 4 of the screw terminal block.
Connecting Voltage Inputs to Voltage Channels

Each DT8873 and DT8874 contains pluggable screw terminals for connecting voltage inputs.

**Note:** On the standard DT8874 instrument, channels 32 to 47 correspond to the voltage input channels.

Figure 22 shows the numbering of the screw terminal blocks for voltage connections.

![Figure 22: Screw Terminal Block Numbering for Voltage Connections](image-url)
Figure 23 shows how to connect voltage inputs to the DT8873 and DT8874.

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs.

Note: For best accuracy when connecting voltage inputs, use twisted-pair wires with a dead-ended shield connected to pin 4 of the screw terminal block.
Connecting Current Loop Inputs

In some applications, such as solar cell, fuel cell, and car battery testing applications, you may want to accurately sense and measure current in a high voltage loop.

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide channel-to-channel functional isolation of 60 VDC maximum continuous working voltage, meaning that each input can be referenced to 60 VDC maximum, with a 500 Vpk withstand rating, verified by a 5 s dielectric withstand test.

The way you connect current loop inputs depends on the channel type you are using. This section describes how to connect current loop inputs to thermocouple input channels, RTD input channels, and voltage input channels.

Connecting Current Loop Inputs to Thermocouple Channels

Thermocouple input channels on the DT8871U and DT8874 have an input range of ±0.075 V. Therefore, you can use a 1 Ω series resistor to measure ±0.075 A. Similarly, you can use a 0.1 Ω series resistor to measure ±0.75 A.

Thermocouple input channels on the DT8871 have an input range of ±1.25 V. Therefore, you can use a 1 Ω series resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω series resistor to measure ±12.5 A or a 10 Ω series resistor to measure ±0.125 A.

Figure 24 shows how to wire your signals to measure a current loop. In this example, the input is referenced to ±60 V.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple input channels.
Use a 1 Ω series resistor to convert current to voltage.

For thermocouple channels on the DT8871U and DT8874, $1 \Omega = 0.075 \text{ A} = 0.075 \text{ V}$.
For thermocouple channels on the DT8871, $1 \Omega = 1.25 \text{ A} = 1.25 \text{ V}$.

Figure 24: Connecting Current Loop Inputs to Thermocouple Channels
Connecting Current Loop Inputs to RTD Channels

RTD channels on the DT8872 and DT8874 instruments have an input range of ±1.25 V. Therefore, you can use a 1 Ω shunt resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω shunt resistor to measure ±12.5 A or a 10 Ω shunt resistor to measure ±0.125 A.

Figure 25 shows how to wire your signals to measure a current loop. In this example, the input is referenced to ±60 V.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input channels.

Use a 1 Ω shunt resistor to convert current to voltage: 1 Ω = 1.25 A = 1.25 V.

Figure 25: Connecting Current Loop Inputs to RTD Channels
Connecting Current Loop Inputs to Voltage Channels

Voltage input channels on the DT8873 and DT8874 instruments have an input range of ±10 V or ±60 V. You select the input range for each channel using software.

With the 24-bit A/D converter, high current, high side current shunts can be used for resolutions of less than 0.01 A on a 100 A range.

Typical Shunts:
- Vishay WSMS5515
  0.2 mΩ – 2 Ω – 100 A – 20 μV
- Vishay CSM2512S
  10 mΩ – 1 Ω – 10 A – 100 μV
- Deltec MUB-500-50
  0.1 mΩ – 25 Ω – 500 A – 50 μV

Notes: On the DT8874 instrument, channels 32 to 47 correspond to the voltage input channels.

Figure 26 shows an example of wiring signals to measure ±20 mA using the ±10 V input range.

![Figure 26: Connecting a Current Loop Input to a Voltage Channel to Measure ±20 mA](image-url)
Connecting Digital I/O Signals

To make digital I/O connections easier, you can use the optional STP37 screw terminal panel and EP333 cable with your TEMPpoint, VOLTpoint, or MEASURpoint instrument. Connect the STP37 to the digital I/O connector of the instrument as shown in Figure 27:

Figure 27: Connecting the Instrument to the STP37

Figure 28 shows the layout of the STP37 screw terminal panel and lists the assignments of each screw terminal.
Connecting Digital Input Signals

Figure 29 shows how to connect digital input signals (lines 0 and 1, in this case) to the digital I/O connector on the TEMPpoint, VOLTpoint, or MEASURpoint instrument.

*1 kΩ pull-up to +5 V required for TTL outputs.*
Connecting Digital Output Signals

The digital output lines of a TEMPpoint, VOLTpoint, or MEASURpoint instrument act as solid-state relays. The customer-supplied signal can be ±30 V at up to 400 mA (peak) AC or DC.

You can use the digital output lines of the instrument to control solid-state or mechanical relays or high-current electric motors. Figure 30 shows how to connect digital output signals to line 0 of the instrument to control a motor relay.

Note: Relay, motor, and circuits must be properly rated. Reinforced isolation must be maintained between the digital output circuits and the relay/motor switching circuits.

Figure 30: Switching up to 30 V at 400 mA
Configuring the Instrument Using the Web Interface

Before Using the Web Interface .......................................................... 69
Locating Your Instrument on the LAN ............................................... 75
Configuring the Instrument ................................................................. 79
Measuring Data and Controlling the Instrument .............................. 87
Downloading Measurements ............................................................... 91
You can configure the operation of your instrument either locally or remotely using the instrument’s web interface.

If your browser supports Java, you can also verify the operation of your instrument using the web interface.

The QuickDAQ application that is provided as part of the MEASURpoint software also allows you to verify the operation of your instrument and does not require Java for operation; therefore, if your browser does not support Java, use QuickDAQ instead. Refer to the documentation provided with QuickDAQ for more information.

This chapter focuses on configuring your instrument using the web interface.

**Note:** DT8871, DT8871U, DT8872, and DT8873 instruments with firmware version 2.2.3.1 or greater are identified in firmware as DT8874-xxT-xxR-xxV, where xxT specifies the number of thermocouple channels, xxR specifies the number of RTD channels, and xxV specifies the number of voltage input channels.
Before Using the Web Interface

This section describes system requirements and browser settings for proper operation of the instrument’s web interface.

**Note:** At any instant, up to 8 clients can access the instrument concurrently using the web interface.

Up to 12 additional clients can access the instrument concurrently using SCPI commands over VISA or sockets. Of these, 4 can be VXI-11 clients, which use the ::SOCKETS or VISA::INSTR resource to access the instrument.

At this time, the web and SCPI interfaces cannot be "locked;" therefore, one client can change the configuration of the instrument that another client is accessing. However, you can optionally lock the VXI-11 interface using the VISA APIs viLock/viUnlock; this prevents other VXI-11 clients (including VXI-11 discovery) from accessing the instrument. Refer to the SCPI documentation for your instrument for more information on supported SCPI commands.

**Java Requirements**

To verify the operation of your instrument through the web interface, your browser must support Version 6, Update 5 or greater of Java. If your browser does not support Java, you can still configure your instrument through the web interface; however, you must use QuickDAQ to verify the operation of your instrument in this case.

You can verify Java versions and settings by accessing the Java Control Panel, select Windows **Start -> Control Panel** and open the **Java** dialog. To download or upgrade Java, go to www.java.com.

**Internet Explorer Browser Settings**

If you have an older version of Internet explorer that supports Java, configure your browser as follows; otherwise, skip this section:

- JavaScript (Active Scripting) must be enabled
- Security level of the instrument’s IP address must be Medium-high or lower
- Pop-up blockers must be disabled

The following sections describe how to configure these settings.
**JavaScript**

To enable JavaScript (also referred to as Active Scripting), perform the following steps:

1. From the Internet Explorer browser, select **Tools -> Internet Options**.
2. Click the **Security** tab.
3. Select **Internet**, and then click **Custom Level**.
4. Scroll down to the **Scripting** section.
5. Under **Active Scripting**, select **Enable**, and then click **OK**.

**Security Levels**

By default, the IP address of the instrument is added to the Internet zone. If you’d rather leave the settings of the Internet zone at a level higher than Medium-high, then you can add the IP address of the instrument to either the Local intranet or Trusted sites zone and configure the security level of that zone to Medium-high or lower.

The following section describe how to configure each zone.

**Internet Zone**

To configure the security level of the instrument module’s IP address in the Internet zone, perform the following steps:

1. From the Internet Explorer browser, select **Tools -> Internet Options**.
2. Click the **Security** tab.
3. Select Internet and move the slide bar to select a security level of Medium-high or lower.
4. Click OK.

**Local Intranet Zone**

To add the IP address of the instrument to the Local intranet zone and configure its security level, do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.
2. Click the Security tab.
3. Click Local intranet, and click Sites.
4. Select which web sites to add to the zone, and then click Advanced.
5. Enter the IP address of the instrument to the zone, and click Add.
6. Click **Close**.

7. Move the slide bar to select a security level of Medium-high or lower.

8. Click **OK**.

**Trusted Sites Zone**

To add the instrument’s IP address to the **Trusted sites** zone and configure its security level, do the following:

To add the IP address of the instrument to the **Trusted sites** zone and configure its security level, do the following:

1. From the Internet Explorer browser, select **Tools -> Internet Options**.
2. Click the **Security** tab.
3. Click **Trusted sites**, and click **Sites**.
4. Enter the IP address of the instrument to the zone (note that the address must be prefaced by (**https://**)), and click **Add**.
5. Click Close.
6. Move the slide bar to select a security level of Medium-high or lower.
7. Click OK.

**Pop-up Blockers**

To disable pop-up blockers, perform the following steps:

1. From the Internet Explorer browser, select **Tools -> Pop-up Blocker**.
2. Select **Turn Off Pop-up Blocker**.
Chapter 5

Associating CSV Files with Microsoft Excel or Notepad

Note: This section applies only if your browser supports Java. If your browser does not support Java, downloading data to a file through the web interface is not supported.

If files with the .CSV extension do not have the proper file associations/actions set up, then clicking Download in the Download Measurements page of the instrument web interface will not present the option of saving the data to a file or loading the data to an application, such as Microsoft Excel® or Microsoft® Notepad, that can display it. Instead, the data will be displayed in the browser.

The following steps describe how to associate a CSV file with Microsoft Excel or Notepad in Windows XP; refer to the documentation for your operating system for more information:

1. From the Windows Control Panel, open the Folder Options dialog, and select File Types.
2. Scroll down to the CSV entry and select it. (If it is not in the list add it as a new file type by selecting New and entering CSV).
3. Click Advanced to access the Edit File Type dialog box.
4. Click New to access the New Action dialog box.
5. Enter Open in the Action: edit field.
6. Click Browse and find Excel.exe (typically located in C:\Program Files\Microsoft Office\OFFICExx\EXCEL.EXE) or Notepad.exe (typically located in C:\Windows\Notepad.exe) on your system, and then click OK.

7. Click OK.

Now when you click Download on the Download Measurements web page, you should see a dialog box asking if you want to Open or Save the data in the appropriate application.
Locating Your Instrument on the LAN

To access the web interface of your instrument, you must determine its IP address on your TCP/IP network.

Note: Discovery works only for devices on the same subnet.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided with the instrument to locate your instrument on the network quickly. Alternatively, you can use other LXI discovery tools, such as Agilent Connection Expert, if you have them installed on your computer. Or you can check your router’s address assignments or locate the instrument’s MAC (Ethernet hardware) address in your DHCP server log.

Running the Eureka Discovery Utility

To use the Eureka Discovery Utility, from the Windows Start menu, click Programs -> Data Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.

A screen similar to the one shown in Figure 31 appears.

![Eureka LXI Discovery Utility](image)

Figure 31: Eureka LXI Discovery Utility

If you are having trouble seeing your instrument in this list, check your Windows firewall settings using the information in the next section; otherwise, skip this section and continue with “Launching the Web Interface” on page 78.
Configuring Windows Firewall Settings

If you are having trouble seeing your instrument using the Eureka Discovery Utility, check your Windows firewall settings by doing the following:

1. Right click in the tile bar of the Eureka Discovery Utility.  
   The following menu options appear:

2. Click the **Firewall Configuration...** option.  
   The following window appears:
3. On the left side of the window, select **Turn Windows Firewall on or off**, select **Turn On Windows Firewall** setting for proper operation of the Eureka Discovery Utility, and click **OK**.

4. On the left side of the window, select **Allow a program or feature through Windows Firewall**, ensure that Eureka LXI Instrument Discovery is included in the list of exceptions, and click **OK**.

5. If Eureka LXI Instrument Discovery is not included in the exception list, add the utility to the list of exceptions by doing the following:
   a. Click **Allow another program...**
   b. Browse to `C:\Program Files\Data Translation\Instrument Support\Eureka.exe`, and click **Open**.
      
      *The Eureka LXI Instrument Discovery utility appears in the window.*
   c. Click **Add** to add the utility to the list of exceptions.
   d. Click **OK** to exit from the Windows Firewall Configuration menu.
Launching the Web Interface

From the Eureka utility, double-click the appropriate IP address to open the web pages for your instrument using your default web browser. Alternatively, you can enter the IP address of your instrument directly in your Internet Explorer address bar to see the instrument’s web interface.

The main web page, similar to the following screen, shows information about your instrument on the network:

![Device Information](image)

**Note:** If your browser does not support Java, the Measurement & control -> Acquisition and Measurement & control -> Digital input pages of the web interface are not supported. To acquire and view input data, use the QuickDAQ application instead.

If you have multiple instruments connected to the network, you can click "Turn ON front panel identification indicator" to light the LAN LED on the instrument, described on page 40, to indicate the device you are using.

To change the description, IP address, or time source associated with the instrument, click the Modify links to navigate to the LAN Configuration page, described on page 79.
Configuring the Instrument

Web pages are provided for configuring the following aspects of your instrument:

- Local Area Network (LAN) settings
- Channels that you want to measure
- Scan rate
- Filter
- Alarm limits
- Digital I/O lines

LAN Configuration

Use the Configuration -> LAN web page to configure the Local Area Network (LAN) settings for the instrument. A screen similar to the following appears:

![LAN Configuration Screen](image)

When you first access your instrument, the LAN settings that the instrument obtained through DHCP or AutoIP should be sufficient. If you need to make changes later, click the Modify button to enable changes. Contact your system administrator and view the instrument’s built-in help pages to determine the correct LAN settings.
Note: If you want to assign a static IP address, ensure that you uncheck the checkbox called Automatic private IP address enabled.

When you click Modify, you must supply a password for the instrument.

The username is admin; it cannot be changed. The default password is admin. You can change the password on this page.

Note that the new password is saved in permanent memory in the instrument and goes into effect after the instrument reboots. If you are prompted for a password before the instrument reboots, you must enter your original password. The web interface, IVI-COM driver, and SCPI interface use the same password. You can also configure the password using the IVI-COM driver or through SCPI commands.

You are prompted for this password any time the instrument’s configuration is changed or when an attempt is made to start or stop a scan. This mechanism relies on features in the HTTP standard to prevent unauthorized users from reconfiguring or operating the instrument. Note, however, that authentication is not required to view the instrument’s configuration or scan results.

Note: The DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments with firmware version 2.2.3.1 or greater use the default user name admin and the default password admin. Firmware version 2.2.3.1 and greater support password-protected commands. Therefore, you must enter the appropriate password to change the instrument’s configuration or to start and stop a scan.

If the firmware version for these instruments is less than 2.2.3.1, then the default user name is sysadmin and the default password is user. Firmware versions less than 2.2.3.1 do not support password-protected commands. Therefore, you are not prompted to enter a password to change the instrument’s configuration or to start or stop a scan.

Specify the time zone that is used by the instrument as an offset (either + or –) from GMT (Greenwich Mean Time). The specified hour and minute is added to the UTC (Coordinated Universal Time) time that is maintained by the instrument. For example choosing –5 hours, 0 minutes sets the current time zone used by the instrument to five hours and 0 minutes behind GMT.

Channel Configuration

Use the Configuration -> Channel web page to enable the channels that you want to measure, specify the sensor to use for each channel, and add a label to describe each channel, if desired. A screen similar to the following appears:
To change your channel configuration, do the following:

1. Under **Enable Channel**, check the boxes next to the channels that you want to collect data. You can use the **Enable All** and **Disable All** buttons for quick configuration of many channels.

2. Under **Type**, select the sensor type for each configured channel from the drop-down list boxes. If all the channels are of the same type (thermocouple, RTD, or voltage), you can use the **Set all** button to change all channels to the sensor type specified in the heading’s drop-down list box.

3. Describe the channels, if desired, by entering text in the **Label** field corresponding to the channel that you want to describe.

4. Click **Save configuration** to apply your changes. If you do not save before leaving this page, your changes are lost.

You can also click the **Discard changes** button (before you save) to return to the previous configuration, if desired.
Scan Rate

Use the Configuration -> Scan Rate web page to set the scan rate for all channels on the instrument. A screen similar to the following appears:

To change your instrument’s scan rate, do the following:

1. Type a value, in Hertz, between the minimum and maximum shown in the Scan Rate field.

   **Note:** The scan rate that you specify is rounded to the closest "correct" value that the instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in the range of 1 to 65535 (the internal clock divider) to determine the closest value. When you save the scan rate configuration, the actual scan rate is shown.

2. Click **Save configuration** to apply your changes. If you do not save before leaving this page, your changes are lost.

You can also click the **Discard changes** button (before you save) to return to the previous configuration, if desired.
Filter Configuration

Use the Configuration -> Filter web page to configure the filter type used by the instrument. A screen similar to the following appears:

You can choose one of the following filter types:

- **Raw** – No filter. Provides fast response times, but the data may be difficult to interpret. Use when you want to filter the data yourself.

  The Raw filter type returns the data exactly as it comes out of the Delta-Sigma A/D converters. Note that Delta-Sigma converters provide substantial digital filtering above the Nyquist frequency.

  Generally, the only time it is desirable to use the Raw filter setting is if you are using fast responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much response speed as possible.

- **Moving average** – (The default filter setting.) Provides a compromise of filter functionality and response time. This filter can be used in any application.

  This low-pass filter takes the previous 16 samples, adds them together, and divides by 16.
### Alarm Limits Configuration

Use the **Configuration -> Limits** web page to define alarm conditions for specific enabled channels that you want to measure. A screen similar to the following appears.

![Alarm Limits Configuration Image](image)

If the alarm condition occurs, the specified digital output line is turned on.

To set up limit checking, do the following:

1. Under **Limit**, click the **Enable** buttons next to the channels for which you want to define limits. You can use the **Disable All** button to quickly stop limit checking on all channels. For each channel:
   - **Enable**
   - **Low Limit**
   - **High Limit**
   - **Digital Output**
2. Enter a value in the **Low Limit** text box.
3. Enter a value in the **High Limit** text box.
4. (Optional) Select a **Digital Output** line to set from the drop-down list box for this channel. This line is set to 1 when the limit range (high or low) is exceeded.

   When multiple channels are configured to set a digital output line, a logical OR condition exists between them, and any value out of range sets the line to 1.
5. Click **Save configuration** to apply your changes. If you do not save before leaving this page, your changes are lost.
You can also click the **Discard changes** button (before you save) to return to the previous configuration, if desired.

**Digital Input and Trigger Configuration**

Use the **Configuration -> Digital Input & Trigger** web page to configure the digital input lines of your instrument:

To change your digital input configuration, do the following:

1. Describe the digital input lines, if desired, by entering text in the **Label** field corresponding to the digital input line that you want to describe.

2. To enable use of an external, digital trigger on digital input line 0, click the **Enable** checkbox under the External trigger heading.

3. Click **Save configuration** to apply your changes. If you do not save before leaving this page, your changes are lost.

You can also click the **Discard changes** button (before you save) to return to the previous configuration, if desired.
Digital Output Configuration

Use the Configuration -> Digital Out web page to configure the digital output lines of your instrument:

To change your digital output configuration, do the following:

1. Describe the digital output lines, if desired, by entering text in the Label field corresponding to the digital output line that you want to describe.

2. Click Save configuration to apply your changes. If you do not save before leaving this page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous configuration, if desired.
**Measuring Data and Controlling the Instrument**

If your browser supports Java, use the Control web pages start or stop data acquisition on the sensor channels or to update the value of the digital output line.

**Starting and Stopping a Scan**

**Note:** If your browser does not support Java, the Measurement & control -> Acquisition page of the web interface is not supported. To acquire and view input data, use the QuickDAQ application instead.

If your browser supports Java, start or stop a scan, using the Measurement & control -> Acquisition web page.

Press the **Start scan** button to begin acquiring data from the sensors. The measurements are displayed on the screen. Press the **Stop scan** button to stop acquiring data from the sensors.

Notice the following aspects of the display:

- When acquiring data, the **Start scan** button changes to say **Stop scan** and the currently configured scan rate is displayed.
• Each box on the Meter tab represents one of the analog input channels, in the same position as the physical connectors.

• If you configured custom labels for some of the channels, those labels are shown here rather than the channel numbers.

• Red boxes indicate that the value is out of range for the specified sensor type.

• The values are updated only for the channels that you enabled, and at the scan rate you configured.

Controlling the Digital Outputs

Use the Measurement & control -> Digital Output web page to view the current state of the digital output lines, and manually change them if desired. A screen similar to the following appears:

![Digital Output Status and Control](image)

Green indicates that the digital output line/relay is closed; red indicates that the digital output line/relay is open.

**Note:** You cannot change the configuration of digital output lines that were configured for limit checking on the Configuration -> Limits page.
To change the status of a digital output line/relay, click the **Open/Close** toggle buttons under the **Change State** heading for the digital output lines that you want to change. You can use these controls to activate or deactivate an external device based on criteria other than temperature that you define.
Reading the Digital Inputs

Note: If your browser does not support Java, the Measurement & control -> Digital input page of the web interface is not supported. To acquire and view input data, use the QuickDAQ application instead.

If your browser supports Java, you can use the Measurement & control -> Digital Input web page to view the current value of the digital input port while the instrument is scanning. A screen similar to the following appears:

If you configured custom labels for the digital input lines, those labels are shown here.

The Current state LEDs show green if the digital input line is on (relay is closed) or red if the digital input line is off (relay is open).
Downloading Measurements

Note: This section applies only if your browser supports Java. If your browser does not support Java, downloading data to a file through the web interface is not supported.

If your browser supports Java, ensure that you have associated CSV files with Microsoft Excel or Notepad, described on page 74, or the data will be displayed in the browser and not saved to a file.

If your browser supports Java, you can use the File -> Download Measurements web page to download your measurement results, including timestamp and limit values, if applicable, to disk. A screen similar to the following appears:

Measurements taken by the instrument are stored in a large circular buffer; when the buffer is full, the oldest data is overwritten with the most recent data.

To download your data, do the following:

1. Click the Download button on this page.

   If scanning has been stopped, all the data in the buffer is downloaded to a comma-separated CSV file, starting with the most recent data.
If scanning is in progress, a snapshot of the data from the most recent data (at the time that the **Download** button was clicked) to the oldest data in the buffer is downloaded to a comma-separated CSV file.

2. In the resulting dialog box, choose **Open** or **Save**.
   - If you choose **Open**, the CSV file opens in the associated application (Microsoft Excel or Notepad).
   - If you choose **Save**, you can open the CSV file in Microsoft Excel, Notepad, or other utilities for analysis at a later time.

Under some circumstances, your data may be displayed in a frame in the browser, or Excel may open the data in the frame. Change your Microsoft Excel, Microsoft Explorer, and Internet Explorer settings to turn off these behaviors and open your files directly in Excel.
Part 2: Using Your Instrument
Principles of Operation

Block Diagrams ................................................................. 96
Analog Input Features ............................................................. 101
Digital I/O Features .............................................................. 112
Block Diagrams

This section includes the block diagrams for the DT8871U, DT8871, and DT8872 TEMPpoint instruments, DT8873 VOLTpoint instrument, and DT8874 MEASURpoint instruments.

DT8871U Block Diagram

Figure 32 shows the block diagram of the DT8871U TEMPpoint instrument.

Figure 32: Block Diagram of the DT8871U TEMPpoint Instrument

*The USB LED is not used on this instrument.
Figure 33 shows the block diagram of the DT8871 instrument.

*The USB LED is not used on this instrument.
Figure 34 shows the block diagram of the DT8872 TEMPpoint instrument.

Figure 34: Block Diagram of the DT8872 TEMPpoint Instrument

*The USB and Open TC LEDs are not used on this instrument.
**Figure 35** shows the block diagram of the DT8873 VOLTpoint instrument.

*The USB and Open TC LEDs are not used on this instrument.*
Figure 36 shows the block diagram of the DT8874 MEASURpoint instrument.

Figure 36: Block Diagram of the DT8874 MEASURpoint Instrument
Analog Input Features

This section describes the following features of the analog input (A/D) subsystem on TEMPpoint, VOLTpoint, and MEASURpoint instruments:

- Analog input channels, described on this page
- Input ranges, described on page 104
- Resolution, described on page 106
- Calibration, described on page 106
- Sample clock, described on page 107
- Trigger source, described on page 107
- Conversion modes, described on page 108
- Filtering, described on page 110
- Data format, described on page 110
- Error conditions, described on page 111

Analog Input Channels

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide up to 48 analog input channels. The number of channels and the channel types supported (thermocouple, RTD, or voltage input) depend on the specific instrument model you purchased, as shown in Table 3.

<table>
<thead>
<tr>
<th>Instrument Type</th>
<th>Models</th>
<th># of Analog Input Channels</th>
<th>Channel Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMPpoint</td>
<td>DT8871U-8 and DT8871-8</td>
<td>8</td>
<td>8 thermocouple inputs (numbered 0 to 7)</td>
</tr>
<tr>
<td>DT8871U-16 and DT8871-16</td>
<td>16</td>
<td>16 thermocouple inputs (numbered 0 to 15)</td>
<td></td>
</tr>
<tr>
<td>DT8871U-24 and DT8871-24</td>
<td>24</td>
<td>24 thermocouple inputs (numbered 0 to 23)</td>
<td></td>
</tr>
<tr>
<td>DT8871U-32 and DT8871-32</td>
<td>32</td>
<td>32 thermocouple inputs (numbered 0 to 31)</td>
<td></td>
</tr>
<tr>
<td>DT8871U-40 and DT8871-40</td>
<td>40</td>
<td>40 thermocouple inputs (numbered 0 to 39)</td>
<td></td>
</tr>
<tr>
<td>DT8871U-48 and DT8871-48</td>
<td>48</td>
<td>48 thermocouple inputs (numbered 0 to 47)</td>
<td></td>
</tr>
<tr>
<td>DT8872-8</td>
<td>8</td>
<td>8 RTD inputs (numbered 0 to 7)</td>
<td></td>
</tr>
<tr>
<td>DT8872-16</td>
<td>16</td>
<td>16 RTD inputs (numbered 0 to 15)</td>
<td></td>
</tr>
<tr>
<td>DT8872-24</td>
<td>24</td>
<td>24 RTD inputs (numbered 0 to 23)</td>
<td></td>
</tr>
<tr>
<td>DT8872-32</td>
<td>32</td>
<td>32 RTD inputs (numbered 0 to 31)</td>
<td></td>
</tr>
<tr>
<td>DT8872-40</td>
<td>40</td>
<td>40 RTD inputs (numbered 0 to 39)</td>
<td></td>
</tr>
<tr>
<td>DT8872-48</td>
<td>48</td>
<td>48 RTD inputs (numbered 0 to 47)</td>
<td></td>
</tr>
<tr>
<td>Instrument Type</td>
<td>Models</td>
<td># of Analog Input Channels</td>
<td>Channel Types</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>----------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>VOLTpoint</td>
<td>DT8873-8</td>
<td>8</td>
<td>8 voltage inputs (numbered 0 to 7)</td>
</tr>
<tr>
<td></td>
<td>DT8873-16</td>
<td>16</td>
<td>16 voltage inputs (numbered 0 to 15)</td>
</tr>
<tr>
<td></td>
<td>DT8873-24</td>
<td>24</td>
<td>24 voltage inputs (numbered 0 to 23)</td>
</tr>
<tr>
<td></td>
<td>DT8873-32</td>
<td>32</td>
<td>32 voltage inputs (numbered 0 to 31)</td>
</tr>
<tr>
<td></td>
<td>DT8873-40</td>
<td>40</td>
<td>40 voltage inputs (numbered 0 to 39)</td>
</tr>
<tr>
<td></td>
<td>DT8873-48</td>
<td>48</td>
<td>48 voltage inputs (numbered 0 to 47)</td>
</tr>
<tr>
<td>MEASURpoint</td>
<td>DT8874-16T-16R-16V</td>
<td>48</td>
<td>16 thermocouple inputs (numbered 0 to 15)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>16 RTD inputs (numbered 16 to 31)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>16 voltage inputs (numbered 32 to 47)</td>
</tr>
</tbody>
</table>

**Thermocouple Input Channels**

For channels that support thermocouples, you can attach a voltage input or any of the following thermocouple types in a mix and match fashion: B, E, J, K, N, R, S, and/or T.

By default, these channels are configured for voltage inputs. You can specify the thermocouple types for channels over the LAN using the web interface, as described in “Channel Configuration” on page 80, in the QuickDAQ application, or by using an API call in your application program. You can also use standard SCPI commands over VISA or sockets, if desired.

**Note:** In a mix-and-match system, it is easy to accidentally mismatch the software and hardware configuration for a channel. Therefore, it is recommended that you pay particular attention when configuring channels, since the resultant errors may be not large enough to notice initially, but may be significantly larger than the accuracy specification for the instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer to page 108 for more information on specifying the channels for a scan.

Table 4 lists the supported measurement range for each thermocouple type. (Refer to page 104 for information on the supported input range for voltage measurements.)
Refer to Appendix A for the thermocouple accuracy of thermocouple channels over the dynamic range of the instrument.

**Cold Junction Compensation**

Each thermocouple channel has its own cold-junction compensation (CJC) at the input. The software reads the value of the CJC input along with the value of the analog input channel and automatically corrects for errors based on the specified thermocouple type and the thermocouple linearization data stored in onboard ROM.

A separate multiplexed A/D is used to acquire all the CJC input values. The software takes care of correlating the CJC measurements with the analog input measurements.

**Note:** The software provides the option of returning CJC values in the data stream. This option is seldom used, but is provided if you want to implement your own temperature conversion algorithms in software when using continuous operations. Refer to page 110 for more information on this feature.

**Open Thermocouple Detection**

Break detection circuitry (+10 nA on the DT8871U and DT8874; +100 nA on the DT8871) is provided for thermocouple channels to ensure that open thermocouples are detected. The Open (OPN) LED on the rear panel lights when this condition occurs; see Figure 14 on page 42 for the location of this LED.

---

**Table 4: Supported Measurement Range for Each Thermocouple Type**

<table>
<thead>
<tr>
<th>Thermocouple Type</th>
<th>Supported Measurement Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimum</td>
</tr>
<tr>
<td>B</td>
<td>250°C (482°F)</td>
</tr>
<tr>
<td>E</td>
<td>−200°C (−328°F)</td>
</tr>
<tr>
<td>J</td>
<td>−210°C (−346°F)</td>
</tr>
<tr>
<td>K</td>
<td>−200°C (−328°F)</td>
</tr>
<tr>
<td>N</td>
<td>−200°C (−328°F)</td>
</tr>
<tr>
<td>R</td>
<td>−50°C (−58°F)</td>
</tr>
<tr>
<td>S</td>
<td>−50°C (−58°F)</td>
</tr>
<tr>
<td>T</td>
<td>−200°C (−328°F)</td>
</tr>
</tbody>
</table>
In addition, the software returns the value SENSOR_IS_OPEN (99999 decimal) for any channel that was configured for a thermocouple input and has either an open thermocouple or no thermocouple connected to it. This value is returned anytime a voltage greater than 100 mV is measured on the input, since this value is greater than any legitimate thermocouple voltage.

If the channel is configured for a voltage input (not a thermocouple type), the Open (OPN) LED never lights and the SENSOR_IS_OPEN value is not returned. Instead, the voltage value is returned. If no input is connected to the channel, the software returns a value of approximately 0.7 V due to the open thermocouple detection pull-up circuit.

**RTD Channels**

For channels that support RTDs, you can attach a voltage input or any of the following RTD types in a mix and match fashion: Platinum 100 Ω (Pt100), Platinum 500 Ω (Pt500), or Platinum 1000 Ω (Pt1000) RTD using an European alpha curve of 0.00385 or an American alpha curve of 0.00392. The supported temperature measurement range for these RTD types is –200° C (–328° F) to 850° C (1562° F). You can also measure a resistance value between 0 and 4k Ohms, if desired. (Refer to page 104 for information on the supported input range for voltage measurements.)

By default, all channels are configured for voltage inputs. You can specify the RTD types for channels over the LAN using the web interface, as described in “Channel Configuration” on page 80, in the QuickDAQ application, or by using an API call in your application program. You can also use standard SCPI commands over VISA, if desired.

---

**Note:** In a mix-and-match system, it is easy to accidentally mismatch the software and hardware configuration for a channel. Therefore, it is recommended that you pay particular attention when configuring channels, since the resultant errors may be not large enough to notice initially, but may be significantly larger than the accuracy specification for the instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer to page 108 for more information on specifying the channels for a scan.

**Input Ranges**

The input voltage range that is supported by your TEMPpoint, VOLTpoint, or MEASURpoint instrument depends on the specific instrument model that you purchased, as shown in Table 5.
Out of Range Data for Thermocouple Channels

Each thermocouple type corresponds to an allowable voltage range. If a voltage is measured on the input that is outside of the legal range for the selected thermocouple type, the channel may be configured for the wrong type of thermocouple or something other than a thermocouple may be connected to the channel.

For channels configured with a thermocouple type of None (voltage), the Limit (LMT) LED on the rear panel of the instrument lights to alert you when the voltage is out of range; see Figure 14 on page 42 for the location of this LED.

For channels configured with a thermocouple type other than None (voltage), the LMT LED lights when the temperature limit is out of range for the specified thermocouple type.

In addition, if the input voltage is less than the legal voltage range for the selected thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888 decimal). If the input voltage is greater than the legal voltage range for the selected thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_HIGH (88888 decimal).

Note: If you are continuously measuring from a properly configured thermocouple input channel and the thermocouple opens or becomes disconnected, the open thermocouple pull-up circuit causes the input voltage to rise to approximately 0.7 V over a few seconds.

In this case, the temperature value rises very quickly, and you will receive the TEMP_OUT_OF_RANGE_HIGH (88888 decimal) value followed by the OPEN_SENSOR (99999 decimal) value. In this case, the OPN LED lights when the open thermocouple is detected and the LMT LED lights when the temperature limit is out of range for the thermocouple type.

---

### Table 5: Supported Input Ranges

<table>
<thead>
<tr>
<th>Instrument Type</th>
<th>Models</th>
<th>Input Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMPpoint</td>
<td>DT8871U</td>
<td>±0.75 V for all channels</td>
</tr>
<tr>
<td>DT8871</td>
<td>±1.25 V for all channels</td>
<td></td>
</tr>
<tr>
<td>DT8872</td>
<td>±1.25 V for all channels</td>
<td></td>
</tr>
<tr>
<td>VOLTrpoint</td>
<td>DT8873</td>
<td>±10 V or ±60 V (software-selectable for each channel)^(a)</td>
</tr>
<tr>
<td>MEASURpoint</td>
<td>DT8874-16T-16R-16V</td>
<td>±0.75 V for channels 0 to 15; ±1.25 V for channels 15 to 31; ±10 V or ±60 V for channels 32 to 47 (software-selectable for each channel)^(a)</td>
</tr>
</tbody>
</table>

^a. Note that the maximum input voltage for the ±60 V range cannot be more than 30 Vrms, 42.4 Vpk, 60 VDC.
Out of Range Data for RTD Channels

Each RTD type corresponds to an allowable voltage range. If a voltage is measured on the input that is outside of the legal range for the selected RTD type, the channel may be configured for the wrong type of RTD or something other than an RTD may be connected to the channel.

For channels configured with a RTD type of voltage, the Limit (LMT) LED on the rear panel of the instrument lights to alert you when the voltage is out of range (greater than +1.25 V or less than –1.25 V); see page 42 for the location of this LED. For channels configured with an RTD type other than voltage, the LMT LED lights when the temperature limit is out of range for the specified RTD type.

In addition, if the input voltage is less than the legal voltage range for the selected RTD type, the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888.0 decimal). If the input voltage is greater than the legal voltage range for the selected RTD type, the software returns the value TEMP_OUT_OF_RANGE_HIGH (88888.0 decimal).

Out of Range Data for Voltage Channels

Each voltage input channel has an allowable voltage range (±10 V or ±60 V on MEASURpoint instruments). You configure the input range for each channel using software. If a voltage is measured on the input that is outside of the legal range for that channel, the Limit (LMT) LED on the rear panel of the instrument lights to alert you; see page 42 for the location of this LED.

Resolution

TEMPpoint, VOLTpoint, and MEASURpoint instruments support a resolution of 24 bits for the analog input subsystem; you cannot specify the resolution in software.

Calibration

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument is factory-calibrated to meet or exceed its published specifications using standards traceable to NIST.

The calibration process includes multiple steps. First, the A/D on each channel is calibrated for offset and gain; these values (including the zero point) are stored in ROM. Then, each CJC circuit is calibrated for thermocouple input channels, and the reference current is characterized for RTD channels.

While each instrument was designed to preserve high accuracy measurements over time, it is recommended that your instrument be recalibrated every year to ensure that it meets or exceeds specifications.

You can calibrate your instrument in the field using precise calibration equipment and the Measurement Instrument Calibration Utility. Refer to the help file for the Measurement Instrument Calibration Utility for detailed information.
Optionally, you can return your instrument to Data Translation for recalibration. For information on factory recalibration, contact Data Translation at 508-946-5100 (if you are in the USA) or call your local distributor (if you are located outside the USA); see our web site (www.mccdaq.com) for the name and telephone number of your nearest distributor.

In addition, each instrument auto-calibrates on each power-up cycle to guarantee high-accuracy measurements. This process, also known as auto-zeroing, resets the zero point of each A/D. You can also auto-calibrate the instrument at any time (as long as acquisition is not in progress) using a software command. Refer to your software documentation for more information on the auto-calibration feature.

### Sample Clock Source

TEMPpoint, VOLTpoint, and MEASURpoint instruments support an internal clock with a maximum sampling rate of 10 Samples/s.

Use software to specify an internal clock source and a clock frequency between 0.000152590219 Hz and 10.0 Hz.

**Note:** The clock frequency that you specify is rounded to the closest “correct” value that the instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in the range of 1 to 65535 (the internal clock divider) to determine the closest value. Using software, you can query this setting to determine the actual clock frequency that is used.

When the continuous operation is started, all the channels specified in the channel list are read simultaneously at the specified clock frequency.

### Trigger Source

A trigger is an event that occurs based on a specified set of conditions. Acquisition starts when the instrument detects the initial trigger event and stops when you stop the operation.

TEMPpoint, VOLTpoint, and MEASURpoint instruments support the following trigger sources for starting analog input operations:

- **Software trigger** – A software trigger event occurs when you start the analog input operation (the computer issues a write to the instrument to begin conversions).
- **External digital trigger** – An external digital trigger event occurs when the instrument detects a voltage from +3 V to +28 V DC on digital input line 0. Initially, the external signal must be low and then go high for at least 100 ms to be detected as a trigger. Once triggered, the state of digital input 0 is ignored.
Conversion Modes

TEMPpoint, VOLTpoint, and MEASURpoint instruments support simultaneous single value and continuous scan conversion modes for reading input measurements.

This section describes each of these conversion modes.

**Simultaneous Single-Value Operations**

If you want a snapshot of all the analog input channels at one point in time, you can perform a simultaneous single-value operation, also called a single values operation, using SCPI commands.

**Note:** This operation mode is supported in SCPI only; it is not supported by the IVI-COM driver or the instrument’s web interface.

Use one of the :MEASure SCPI commands to specify the channels that you want to sample and the configuration of the channels, if needed. One single value is then acquired from each analog input channel simultaneously and returned.

If you need to continuously acquire data from one or more channels use continuous scan mode, described next, instead.

**Continuous Scan Mode**

Continuous scan mode takes full advantage of the capabilities of the TEMPpoint, VOLTpoint, and MEASURpoint instruments. Use continuous scan mode if you want to accurately control the period between successive simultaneous conversions of specific channels.

In addition to the analog input channels, this conversion mode allows you to read the digital input port (all 8 digital input lines) as part of the analog input data stream. This feature is particularly useful when you want to correlate the timing of analog and digital events.

**Specifying Analog Input Channels**

Using software, enable the analog input channels that you want to sample by specifying the channel numbers in the channel list. You can also read the value of the digital input port through the analog input data stream by specifying the digital input channel in the channel list; the number of the digital input channel depends on how many channels the TEMPpoint, VOLTpoint, or MEASURpoint instrument provides, as shown in Table 6.
Principles of Operation

The channels are read in order from the lowest channel number to the highest channel number in the list of enabled channels; this process is known as a scan.

How Continuous Scan Works

When you issue a command to start the scan, the instrument simultaneously samples all the analog input channels, CJC inputs (if applicable), and the digital input port, and converts the analog inputs to temperature, resistance, or voltage based on the sensor type. If the channel is enabled, the sampled data is placed in the FIFO on the instrument.

The FIFO on the instrument is used as a circular buffer. Acquisition continues indefinitely until you stop the operation. When the FIFO is full, the operation wraps to the beginning of the FIFO; values are overwritten starting at the first location in the FIFO. It is up to your application to retrieve the data from the FIFO; refer to your software documentation for more information.

The conversion rate is determined by the frequency of the input sample clock; refer to page 107 for more information about the input sample clock. The sample rate, which is the rate at which a single entry in the channel list is sampled, is the same as the conversion rate due to the simultaneous nature of the MEASURpoint instrument.

Figure 37 illustrates scanning a list of three enabled channels: channel 0, channel 1, and channel 2. In this example, analog input data is acquired simultaneously on each clock pulse of the input sample clock. Data is acquired continuously.

<table>
<thead>
<tr>
<th>Total Number of Analog Input Channels</th>
<th>Channel for Reading the Digital Input Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 7</td>
<td>8</td>
</tr>
<tr>
<td>0 to 15</td>
<td>16</td>
</tr>
<tr>
<td>0 to 23</td>
<td>24</td>
</tr>
<tr>
<td>0 to 31</td>
<td>32</td>
</tr>
<tr>
<td>0 to 39</td>
<td>40</td>
</tr>
<tr>
<td>0 to 47</td>
<td>48</td>
</tr>
</tbody>
</table>

Table 6: Supported Channels for Continuous Operations

Figure 37: Continuous Scan Mode
Filtering

TEMPpoint, VOLTpoint, and MEASURpoint instruments use a Delta-Sigma analog-to-digital converter (ADC) for each analog input channel to provide simultaneous sampling of all inputs. The Delta-Sigma converter operates at 10 Hz effectively providing a filter that rejects 50 Hz and 60 Hz power line frequency components and that removes aliasing, a condition where high frequency input components erroneously appear as lower frequencies after sampling.

In addition to the filter provided in hardware, you can further reduce noise by selecting one of the following filter options in software: Moving Average or Raw. Refer to page 83 and to your software documentation for more information on selecting a filter type.

Data Format

TEMPpoint, VOLTpoint, and MEASURpoint instruments return data as 32-bit floating-point values. How the data is returned depends on the channel type, as described in the following subsections.

Data Format for Thermocouple Channels

If you specify a thermocouple type of None for a thermocouple input channel, a voltage measurement is selected and the instrument returns a voltage value. For the DT8871U and DT8874 instruments, the value is in the range of ±0.075 V; for the DT8872 instrument, the value is in the range of ±1.25 V. For all other thermocouple types, a temperature value, in degrees C, or one of the error constants, described on page 111, is returned.

In normal operation, one floating-point value is returned for each enabled channel (including the digital input port). If you enable the capability of returning CJC data in the data stream, described on page 103, two floating-point values are returned in the data stream for each enabled analog input channel. The first value in the pair represents the temperature (or voltage) of the channel; the second value in the pair represents the CJC temperature (in degrees C) for that channel.

Data Format for RTD Channels

If you specify an RTD type of None for an RTD input channel, a voltage measurement is selected and the instrument returns a voltage value in the range of ±1.25 V. If you specify an RTD type of Ohms, a resistance value is returned. For all other RTD types, a temperature value, in degrees C, or one of the error constants, described on page 111, is returned.

One floating-point value is returned for each enabled channel (including the digital input port).
**Data Format for Voltage Channels**

For voltage channels on a MEASURpoint instrument, a voltage value in the range of ±10 V or ±60 V is returned, depending on how the channel was configured. Note that the maximum input voltage for the ±60 V range cannot be more than 30 Vrms, 42.4 Vpk, 60 VDC.

One floating-point value is returned for each enabled channel (including the digital input port).

**Error Conditions**

TEMPpoint, VOLTpoint, and MEASURpoint instruments report overrun errors by sending an overrun event to the application program. If this error condition occurs, the instrument stops acquiring and transferring data to the host computer. To avoid this error, try one or more of the following:

- Reduce the sample rate
- Close any other applications that are running
- Run the program on a faster computer

Additionally, the following constants may be reported to the host:

- 99999.0 – SENSOR_IS_OPEN, described on page 103
- 88888.0 – TEMP_OUT_OF_RANGE_HIGH, described on page 105 and page 106
- –88888.0 – TEMP_OUT_OF_RANGE_LOW, described on page 105 and page 106

If any of these constants is reported, the A/D subsystem continues to acquire data; the error condition is cleared when the data falls within range.
**Digital I/O Features**

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide 8 digital input lines and 8 digital output lines that you can use to control external equipment, including solid-state or mechanical relays.

This section describes the following digital I/O features:

- Digital input lines, described below
- Digital output lines, described on page 113
- Channel-to-channel functional isolation, described on page 113
- Resolution, described on page 113
- Operation modes, described on page 113

**Digital Input Lines**

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, isolated, digital input lines.

Digital inputs operate from +3 to +28 V DC, with a switching time of 2 ms maximum. Figure 38 shows the digital input circuitry; a 2.2 kΩ resistor is used in series with the LED in the opto-isolator input.

![1 of 8 Opto-Isolators](image)

**Figure 38: Digital Input Circuitry**

A digital line is high (switch is closed) if its value is 1; a digital line is low (switch is open) if its value is 0.
Digital Output Lines

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, latched and isolated digital output lines. The outputs are solid-state relays that operate at ±30 V and 400 mA peak (AC or DC). Switching time is 2 ms maximum.

Figure 39 shows the digital output circuitry.

![Diagram of Digital Output Circuitry](image)

Digital outputs resemble a switch; the switch is closed if the state of the digital output line is 1, and the switch is open if the state of the digital output line is 0. On power up or reset, the digital outputs are disabled.

Channel-to-Channel Functional Isolation

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument includes channel-to-channel functional isolation of up to 60 V between digital I/O lines.

Resolution

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument provides 8 bits of resolution for the digital input port to accommodate the 8 digital input lines and 8 bits of resolution for the digital output port to accommodate the 8 digital output lines. These lines are organized as isolated, dedicated ports. You cannot configure port resolution through software.

Operation Modes

Using software, you can read from a single digital input line or the entire digital input port, or write to a single digital output line or the entire digital output port. You can also return the value of the entire digital input port in the analog input data stream if you want to correlate analog input data with digital events; refer to page 108 for more information.
Troubleshooting

General Checklist ................................................................. 116
Technical Support ............................................................... 118
If Your Instrument Needs Factory Service ................................. 119
**General Checklist**

Should you experience problems using a TEMPpoint, VOLTpoint, or MEASURpoint instrument, do the following:

1. Read all the documentation provided for your product, including any “Read This First” information.
3. Check that your system meets the requirements stated in Chapter 2.
4. Check that you have installed your hardware properly using the instructions in Chapter 3.
5. Check that you have wired your signals properly using the instructions in Chapter 4.
6. Search the DT Knowledgebase in the Support section of the Data Translation web site (at www.mccdaq.com) for an answer to your problem.

If you still experience problems, try using the information in Table 7 to isolate and solve the problem. If you cannot identify the problem, refer to page 118.

### Table 7: Troubleshooting Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument is not found.</td>
<td>The instrument cannot communicate with the network.</td>
<td>Ensure that your instrument is properly connected; see the instructions in Chapter 3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If your PC has a static IP address, reconfigure it for Auto-IP using the instructions on page 145.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check your LAN configuration; see the instructions on page 79.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the IP address of the instrument by opening a Command Prompt window (Start -&gt; Programs -&gt; Accessories -&gt; Command Prompt) and entering the command “ipconfig /all”. The IP settings of your instrument are returned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ping the instrument by opening a Command Prompt window (Start -&gt; Programs -&gt; Accessories -&gt; Command Prompt) and entering the command “ping address”, where address is the IP address of your instrument. If a timeout message is returned, the IP address is incorrect. If a &quot;no host&quot; error message is returned, the subnet mask is incorrect. Refer to page 41 for more information on IP and subnet addresses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If needed, reset the instrument using the instructions on page 44.</td>
</tr>
</tbody>
</table>
Table 7: Troubleshooting Problems (cont.)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument does not respond.</td>
<td>The instrument configuration is incorrect.</td>
<td>Check your LAN configuration; see the instructions on page 79.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the IP address of the instrument by opening a Command Prompt window (Start -&gt; Programs -&gt; Accessories -&gt; Command Prompt) and entering the command &quot;ipconfig /all&quot;. The IP settings of your instrument are returned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ping the instrument by opening a Command Prompt window (Start -&gt; Programs -&gt; Accessories -&gt; Command Prompt) and entering the command &quot;ping address&quot;, where address is the IP address of your instrument. If a timeout message is returned, the IP address is incorrect. If a &quot;no host&quot; error message is returned, the subnet mask is incorrect. Refer to page 41 for more information on IP and subnet addresses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If needed, reset the instrument using the instructions on page 44.</td>
</tr>
<tr>
<td>The instrument is damaged.</td>
<td></td>
<td>Contact Data Translation for technical support; refer to page 118.</td>
</tr>
<tr>
<td>Intermittent operation.</td>
<td>Loose connections or vibrations exist.</td>
<td>Check your wiring and tighten any loose connections or cushion vibration sources; see the instructions in Chapter 4.</td>
</tr>
<tr>
<td></td>
<td>The instrument is overheating.</td>
<td>Check environmental and ambient temperature; consult the specifications on page 136 of this manual and the documentation provided by your computer manufacturer for more information.</td>
</tr>
<tr>
<td></td>
<td>Electrical noise exists.</td>
<td>Check your wiring and either provide better shielding or reroute unshielded wiring; see the instructions in Chapter 4.</td>
</tr>
<tr>
<td>Data appears to be invalid.</td>
<td>An open connection exists.</td>
<td>Check your wiring and fix any open connections; see the instructions in Chapter 4.</td>
</tr>
<tr>
<td></td>
<td>A transducer is not connected to the channel being read.</td>
<td>Check the transducer connections; see the instructions in Chapter 4.</td>
</tr>
<tr>
<td></td>
<td>The thermocouple, RTD, or voltage input that you connected to the channel does not match the software configuration for that channel.</td>
<td>Check your wiring and ensure that what you specify in software matches your hardware configuration; see the instructions in Chapter 4.</td>
</tr>
<tr>
<td>Your instrument may need recalibration.</td>
<td></td>
<td>The instrument is calibrated at the factory. Thereafter, yearly calibration is recommended. Use the Measurement Instrument Calibration Utility, described on page 21, or return your instrument to Data Translation for recalibration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information on factory recalibration, contact Data Translation at 508-946-5100 (if you are in the USA) of call your local distributor (if you are located outside the USA); see our web site (<a href="http://www.mccdaq.com">www.mccdaq.com</a>) for the name and telephone number of your nearest distributor.</td>
</tr>
</tbody>
</table>
Technical Support

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments have a 1 year warranty from the factory. If you open the instrument’s enclosure, you will void this warranty.

If you have difficulty using your TEMPpoint, VOLTpoint, or MEASURpoint instrument, Data Translation’s Technical Support Department is available to provide technical assistance.

To request technical support, go to our web site at http://www.mccdaq.com and click on the Support link.

When requesting technical support, be prepared to provide the following information:

- Your product serial number
- The hardware/software product you need help on
- The version of the MEASURpoint Software that you are using
- Your contract number, if applicable

If you are located outside the USA, contact your local distributor; see our web site (www.mccdaq.com) for the name and telephone number of your nearest distributor.
If Your Instrument Needs Factory Service

Most hardware models can be functionally tested, evaluated for repairs (if needed), and calibrated to factory specifications. An RMA # must be obtained from Application Engineering in advance of sending any product back to Measurement Computing. Customers outside of the USA must contact their local distributor for a return procedure. Calibration certificates for most analog models can be obtained for a fee (certificate must be requested at time of RMA # assignment).
Specifications

Basic Instrument Specifications ......................................................... 122
Thermocouple Specifications .......................................................... 123
RTD Specifications ........................................................................ 128
Temperature Specifications ............................................................. 129
Voltage Measurement Specifications .............................................. 131
Isolation and Protection Specifications ........................................... 133
Memory Specifications ................................................................. 134
Digital I/O Specifications ............................................................... 135
Power, Physical, and Environmental Specifications ...................... 136
Regulatory Specifications ............................................................... 137
Connector Specifications ............................................................... 138
External Power Supply Specifications ............................................ 141

Note: All analog input specifications are based on the Moving Average filter type.
### Basic Instrument Specifications

Table 8 lists the basic instrument specifications for the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments. For basic environmental specifications, please see page 136.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels in channel list</td>
<td>Up to 48 analog input channels and one digital input port</td>
</tr>
<tr>
<td>A/D converter type</td>
<td>High stability 24-bit Sigma-Delta</td>
</tr>
<tr>
<td>Measurement category ratings</td>
<td>Do not connect to signals or use for measurements within measurement categories II, III, or IV</td>
</tr>
</tbody>
</table>
**Thermocouple Specifications**

Table 9 lists the specifications for thermocouple channels on the DT8871, DT8871U, and DT8874 instruments.

**Table 9: Thermocouple Specifications**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermocouple types (software-selectable)</td>
<td>B, E, J, K, N, R, S, T</td>
</tr>
<tr>
<td>A/D resolution</td>
<td>24-bits</td>
</tr>
<tr>
<td>Sample rate</td>
<td>10 Samples/s</td>
</tr>
<tr>
<td>Thermal disturbance channel-to-channel</td>
<td>None</td>
</tr>
<tr>
<td>Upscale break detection current</td>
<td></td>
</tr>
<tr>
<td>DT8871U and DT8874:</td>
<td>+10 nA</td>
</tr>
<tr>
<td>DT8871:</td>
<td>+100 nA</td>
</tr>
<tr>
<td>System temperature error</td>
<td></td>
</tr>
<tr>
<td>DT8871U and DT8874:</td>
<td>See Table 10 and Table 11 on page 124</td>
</tr>
<tr>
<td>DT8871:</td>
<td>See Table 12 on page 126</td>
</tr>
</tbody>
</table>
Appendix A

System Temperature Error for the DT8871U and DT8874

Table 10 lists the typical accuracy of the DT8871U and DT8874 for each thermocouple type at several temperature points over the dynamic range of the instrument.

Table 10: Typical Thermocouple Accuracy of the DT8871U and DT8874

<table>
<thead>
<tr>
<th>Input Temp.</th>
<th>J</th>
<th>K</th>
<th>T</th>
<th>E</th>
<th>S</th>
<th>R</th>
<th>B</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>−100°C</td>
<td>±0.17°C</td>
<td>±0.17°C</td>
<td>±0.16°C</td>
<td>±0.16°C</td>
<td>0</td>
<td>0</td>
<td>±0.16°C</td>
<td></td>
</tr>
<tr>
<td>0°C</td>
<td>±0.15°C</td>
<td>±0.16°C</td>
<td>±0.16°C</td>
<td>±0.15°C</td>
<td>±0.20°C</td>
<td>±0.20°C</td>
<td>0</td>
<td>±0.16°C</td>
</tr>
<tr>
<td>100°C</td>
<td>±0.18°C</td>
<td>±0.15°C</td>
<td>±0.16°C</td>
<td>±0.15°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>0</td>
<td>±0.16°C</td>
</tr>
<tr>
<td>300°C</td>
<td>±0.15°C</td>
<td>±0.17°C</td>
<td>±0.16°C</td>
<td>±0.15°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.23°C</td>
<td>±0.15°C</td>
</tr>
<tr>
<td>500°C</td>
<td>±0.15°C</td>
<td>±0.15°C</td>
<td>0</td>
<td>±0.15°C</td>
<td>±0.18°C</td>
<td>±0.17°C</td>
<td>±0.21°C</td>
<td>±0.15°C</td>
</tr>
<tr>
<td>700°C</td>
<td>±0.15°C</td>
<td>±0.15°C</td>
<td>0</td>
<td>±0.16°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.17°C</td>
<td>±0.16°C</td>
</tr>
<tr>
<td>900°C</td>
<td>±0.15°C</td>
<td>±0.17°C</td>
<td>0</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.19°C</td>
<td>±0.16°C</td>
</tr>
<tr>
<td>1100°C</td>
<td>±0.15°C</td>
<td>±0.16°C</td>
<td>0</td>
<td>±0.19°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.16°C</td>
</tr>
<tr>
<td>1400°C</td>
<td>0</td>
<td>±0.18°C</td>
<td>±0.18°C</td>
<td>±0.17°C</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Inclusive of typical 0.15°C CJC error. Exclusive of thermocouple errors.

Table 11 lists the maximum accuracy of the DT8871U and DT8874 for each thermocouple type at several temperature points over the dynamic range of the instrument.

Table 11: Maximum Thermocouple Accuracy of the DT8871U and DT8874

<table>
<thead>
<tr>
<th>Input Temp.</th>
<th>J</th>
<th>K</th>
<th>T</th>
<th>E</th>
<th>S</th>
<th>R</th>
<th>B</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>−100°C</td>
<td>±0.35°C</td>
<td>±0.38°C</td>
<td>±0.39°C</td>
<td>±0.34°C</td>
<td>0</td>
<td>0</td>
<td>±0.43°C</td>
<td></td>
</tr>
<tr>
<td>0°C</td>
<td>±0.33°C</td>
<td>±0.35°C</td>
<td>±0.35°C</td>
<td>±0.32°C</td>
<td>±0.96°C</td>
<td>±0.98°C</td>
<td>0</td>
<td>±0.40°C</td>
</tr>
<tr>
<td>100°C</td>
<td>±0.34°C</td>
<td>±0.31°C</td>
<td>±0.34°C</td>
<td>±0.31°C</td>
<td>±0.77°C</td>
<td>±0.76°C</td>
<td>0</td>
<td>±0.37°C</td>
</tr>
<tr>
<td>300°C</td>
<td>±0.31°C</td>
<td>±0.36°C</td>
<td>±0.32°C</td>
<td>±0.30°C</td>
<td>±0.67°C</td>
<td>±0.65°C</td>
<td>±1.52°C</td>
<td>±0.35°C</td>
</tr>
<tr>
<td>500°C</td>
<td>±0.30°C</td>
<td>±0.33°C</td>
<td>0</td>
<td>±0.30°C</td>
<td>±0.64°C</td>
<td>±0.61°C</td>
<td>±1.02°C</td>
<td>±0.34°C</td>
</tr>
<tr>
<td>700°C</td>
<td>±0.30°C</td>
<td>±0.33°C</td>
<td>0</td>
<td>±0.31°C</td>
<td>±0.62°C</td>
<td>±0.58°C</td>
<td>±0.80°C</td>
<td>±0.35°C</td>
</tr>
<tr>
<td>900°C</td>
<td>±0.30°C</td>
<td>±0.36°C</td>
<td>0</td>
<td>±0.31°C</td>
<td>±0.60°C</td>
<td>±0.56°C</td>
<td>±0.72°C</td>
<td>±0.35°C</td>
</tr>
<tr>
<td>1100°C</td>
<td>±0.31°C</td>
<td>±0.35°C</td>
<td>0</td>
<td>±0.59°C</td>
<td>±0.54°C</td>
<td>±0.65°C</td>
<td>±0.35°C</td>
<td></td>
</tr>
<tr>
<td>1400°C</td>
<td>0</td>
<td>±0.57°C</td>
<td>±0.53°C</td>
<td>±0.59°C</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Maximum accuracy inclusive of 0.25°C CJC error. Exclusive of thermocouple errors.
The histograms shown in Figure 40 and Figure 41 characterize the Gaussian system noise distribution for each of the available filter types on the DT8871U and DT8874. Note that converting μV error to temperature error depends on thermocouple type. For example, a K thermocouple changes approximately 39 μV per degrees C; therefore, a noise level of 0.1 μV adds less than 0.003° C error (0.1 μV / 39 μV) for a type K thermocouple.

Figure 40: System Noise on the DT8871U and DT8874 Using No Software Filter (Raw Filter)

Figure 41: System Noise on the DT8871U and DT8874 Using the Moving Average Filter
System Temperature Error for the DT8871

Table 12 lists the typical accuracy of the DT8871 for each thermocouple type at several temperature points over the dynamic range of the instrument.

Table 12: Typical Thermocouple Accuracy of the DT8871

<table>
<thead>
<tr>
<th>Input Temperature</th>
<th>Thermocouple Typea</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>J</td>
</tr>
<tr>
<td>–100°C</td>
<td>±0.33°C</td>
</tr>
<tr>
<td>0°C</td>
<td>±0.30°C</td>
</tr>
<tr>
<td>100°C</td>
<td>±0.31°C</td>
</tr>
<tr>
<td>300°C</td>
<td>±0.29°C</td>
</tr>
<tr>
<td>500°C</td>
<td>±0.28°C</td>
</tr>
<tr>
<td>700°C</td>
<td>±0.27°C</td>
</tr>
<tr>
<td>900°C</td>
<td>±0.27°C</td>
</tr>
<tr>
<td>1100°C</td>
<td>±0.28°C</td>
</tr>
<tr>
<td>1400°C</td>
<td>--------</td>
</tr>
</tbody>
</table>

a. Conditions for accuracy measurements:
MEASURpoint warm-up time of 1 hour. Inclusive of typical 0.2°C CJC error (maximum CJC error is 0.3°C). Exclusive of thermocouple errors.

The histograms shown in Figure 42 and Figure 43 characterize the Gaussian system noise distribution for each of the available filter types on the DT8871. Note that converting μV error to temperature error depends on thermocouple type. For example, a K thermocouple changes approximately 39 μV per degrees C; therefore, a noise level of 10 μV adds 0.3° C error (10 μV / 39 μV) for a type K thermocouple.
Figure 42: System Noise on the DT8871 Using No Software Filter (Raw Filter)

Figure 43: System Noise on the DT8871 Using the Moving Average Filter
**RTD Specifications**

Table 13 lists the specifications for RTD channels on the DT8872 and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTD types (software-selectable)</td>
<td>Platinum 100 Ω, 500 Ω, and 1000 Ω</td>
</tr>
<tr>
<td>A/D converter resolution</td>
<td>24-bits</td>
</tr>
<tr>
<td>Sample rate</td>
<td>10 Samples/s</td>
</tr>
<tr>
<td>Supported temperature range</td>
<td>–200 to +850°C (European standard)</td>
</tr>
<tr>
<td>Current source Absolute current:</td>
<td>425 μA, ±0.5% at 25°C (calibrated in firmware)</td>
</tr>
<tr>
<td>Drift:</td>
<td>10 ppm/°C maximum</td>
</tr>
<tr>
<td>Drift per year:</td>
<td>±100 ppm typical</td>
</tr>
<tr>
<td>Internal reference</td>
<td>+1.250 ±0.002 V</td>
</tr>
<tr>
<td>Thermal disturbance channel-to-channel</td>
<td>None</td>
</tr>
<tr>
<td>Supported RTD alpha curves</td>
<td>See Table 14</td>
</tr>
</tbody>
</table>

Table 14 lists the RTD alpha curves that are supported by RTD channels.

<table>
<thead>
<tr>
<th>Alpha (Average Temperature Coefficient of Resistance (°C))</th>
<th>Nominal Resistance at 0°C</th>
<th>Organization</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00385</td>
<td>100 Ω</td>
<td>British Standard</td>
<td>BS1904: 1984</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deutschen Institut fur Normung</td>
<td>DIN 43760: 1980</td>
</tr>
<tr>
<td>0.00392</td>
<td>98.129 Ω</td>
<td>Scientific Appartus Manufacturers of America</td>
<td>SAMA RC-4-1966</td>
</tr>
</tbody>
</table>

## Temperature Specifications

Table 15 lists the temperature specifications for thermocouple channels on the DT8871, DT8871U, and DT8874 instruments.

### Table 15: Temperature Stability Specifications for Thermocouple Channels

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional error due to ambient temperature</td>
<td></td>
</tr>
<tr>
<td>change(a)</td>
<td></td>
</tr>
<tr>
<td>J-type thermocouple:</td>
<td>0.010° C per degree ambient change, typical</td>
</tr>
<tr>
<td>K-type thermocouple:</td>
<td>0.011° C per degree ambient change, typical</td>
</tr>
<tr>
<td>B-type thermocouple:</td>
<td>0.014° C per degree ambient change, typical</td>
</tr>
<tr>
<td>E-type thermocouple:</td>
<td>0.010° C per degree ambient change, typical</td>
</tr>
<tr>
<td>N-type thermocouple:</td>
<td>0.011° C per degree ambient change, typical</td>
</tr>
<tr>
<td>R-type thermocouple:</td>
<td>0.012° C per degree ambient change, typical</td>
</tr>
<tr>
<td>S-type thermocouple:</td>
<td>0.012° C per degree ambient change, typical</td>
</tr>
<tr>
<td>T-type thermocouple:</td>
<td>0.010° C per degree ambient change, typical</td>
</tr>
<tr>
<td>MEASUREpoint warm-up time</td>
<td>1 hour</td>
</tr>
<tr>
<td>CJC Error (maximum):</td>
<td>±0.25° C</td>
</tr>
<tr>
<td>Accuracy:</td>
<td>Corrected in ROM @ 25° C to zero error</td>
</tr>
<tr>
<td>Drift per year:</td>
<td>±50 ppm typical</td>
</tr>
</tbody>
</table>

\(a\) Includes the A/D reference, gain, and CJC errors.
Table 16 lists the temperature specifications for RTD channels on the DT8872 and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System temperature error</strong>&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td>Pt100:</td>
<td>Offset (typical): ±0.03°C</td>
</tr>
<tr>
<td></td>
<td>Offset (maximum): ±0.30°C</td>
</tr>
<tr>
<td></td>
<td>RMS noise: 0.03°C</td>
</tr>
<tr>
<td></td>
<td>Temperature resolution: 0.002°C</td>
</tr>
<tr>
<td></td>
<td>Maximum system error: ±0.80° C&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Pt500:</td>
<td>Offset (typical): ±0.007°C</td>
</tr>
<tr>
<td></td>
<td>Offset (maximum): ±0.07°C</td>
</tr>
<tr>
<td></td>
<td>RMS noise: 0.007°C</td>
</tr>
<tr>
<td></td>
<td>Temperature resolution: 0.0004°C</td>
</tr>
<tr>
<td></td>
<td>Maximum system error: ±0.16° C&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Pt1000:</td>
<td>Offset (typical): ±0.003°C</td>
</tr>
<tr>
<td></td>
<td>Offset (maximum): ±0.03°C</td>
</tr>
<tr>
<td></td>
<td>RMS noise: 0.003°C</td>
</tr>
<tr>
<td></td>
<td>Temperature resolution: 0.0002°C</td>
</tr>
<tr>
<td></td>
<td>Maximum system error: ±0.08° C&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>Warm-up time</strong></td>
<td></td>
</tr>
<tr>
<td>MEASURpoint:</td>
<td>1 hour</td>
</tr>
<tr>
<td>RTD sensors and external calibration</td>
<td>1 minute</td>
</tr>
<tr>
<td>resistors:</td>
<td></td>
</tr>
</tbody>
</table>

<sup>a</sup> Includes the A/D reference and gain errors.

<sup>b</sup> Includes a maximum linearity error of 10 ppm and a calibration setup error of 10 ppm. Users must be aware that subtle resistor value tolerances and self-heating of the external calibration resistors contribute calibration setup errors.
# Voltage Measurement Specifications

Table 17 lists the voltage measurement specifications for the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

## Table 17: Voltage Measurement Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range (no compensation)</td>
<td>±0.0750 V</td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>±1.2500 V</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±1.2500 V</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±10 V or ±60 V (software selectable)²</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td></td>
</tr>
<tr>
<td>A/D converter resolution</td>
<td>24-bits</td>
</tr>
<tr>
<td>Voltage resolution</td>
<td></td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>0.015 µV</td>
</tr>
<tr>
<td>DT8871:</td>
<td>0.3 µV</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>0.3 µV</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>1.2 µV for the ±10 V input range;</td>
</tr>
<tr>
<td></td>
<td>12 µV for the ±60 V input range²</td>
</tr>
<tr>
<td>Sample rate</td>
<td>10 Samples/s</td>
</tr>
<tr>
<td>Input impedance</td>
<td></td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>5 MΩ typical</td>
</tr>
<tr>
<td>DT8871:</td>
<td>5 MΩ typical</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>&gt; 100 MΩ</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>&gt; 1 MΩ (Power ON or OFF)</td>
</tr>
<tr>
<td>Input common mode voltage</td>
<td>60 VDC, 30 VAC</td>
</tr>
<tr>
<td>Common mode rejection @ 60 Hz and 50 Hz</td>
<td>&gt; 150 dB</td>
</tr>
<tr>
<td>Coupling</td>
<td>DC</td>
</tr>
<tr>
<td>System linearity</td>
<td>±0.005%</td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>±0.005%</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±0.001%</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±0.001%</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td></td>
</tr>
<tr>
<td>System gain error (includes all noise sources; gain = 1)</td>
<td>±0.00075% of full-scale range</td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>±0.00075% of full-scale range</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±0.00075% of full-scale range</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±0.01% of reading</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td></td>
</tr>
<tr>
<td>System zero error (includes all noise sources; no filter)</td>
<td>0.25 µV RMS</td>
</tr>
<tr>
<td>DT8871U and DT8874 thermocouple channels:</td>
<td>5 µV RMS</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±12 µV</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±300 µV for the ±10 V input range;</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>±2 mV for the ±60 V input range²</td>
</tr>
</tbody>
</table>
### Table 17: Voltage Measurement Specifications (cont.)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>System drift error, zero DT8871U and DT8874 thermocouple channels:</td>
<td>±0.02 μV/°C typical</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±0.02 μV/°C typical</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±0.10 μV/°C</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>±0.5 μV/°C for the ±10 V input range;</td>
</tr>
<tr>
<td></td>
<td>±5 μV/°C for the ±60 V input range¹</td>
</tr>
<tr>
<td>System drift error, gain DT8871U and DT8874 thermocouple channels:</td>
<td>±4 ppm/°C</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±4 ppm/°C</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±10 ppm/°C</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>±15 ppm/°C</td>
</tr>
<tr>
<td>A/D reference</td>
<td></td>
</tr>
<tr>
<td>Drift:</td>
<td>±8 ppm/°C maximum</td>
</tr>
<tr>
<td>Drift per year:</td>
<td>±100 ppm typical</td>
</tr>
<tr>
<td>Full-scale long-term stability DT8871U and DT8874 thermocouple channels:</td>
<td>±100 ppm/year typical</td>
</tr>
<tr>
<td>DT8871:</td>
<td>±100 ppm/year typical</td>
</tr>
<tr>
<td>DT8872 and DT8874 RTD channels:</td>
<td>±0.05°C per year @ 0°C (±0.27°C per year @ full-scale temperature)</td>
</tr>
<tr>
<td>DT8873 and DT8874 voltage channels:</td>
<td>±100 ppm/year typical</td>
</tr>
<tr>
<td>MEASURpoint warm-up time</td>
<td>1 hour</td>
</tr>
</tbody>
</table>

¹ For the ±60 V range, no more than 30 Vrms, 42.4 Vpk, 60 VDC is allowed.
### Isolation and Protection Specifications

Table 18 lists the isolation and protection specifications for the analog input subsystem on the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
</table>
| DT8871U, DT8871, and DT8874 Thermocouple Channels Overvoltage Protection (Power On/Off) | ±40 V  
Validity: 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\) |
| Pin 2 referenced to pin 3: |  |
| Pin 2 and 3 referenced to earth ground: |  |
| DT8872 and DT8874 RTD Channels Overvoltage Protection (Power On/Off) | ±4 V\(^\text{b}\)  
±40 V  
±20 V  
Validity: 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\) |
| Pin 1 referenced to pin 4: |  |
| Pin 2 referenced to pin 4: |  |
| Pin 3 referenced to pin 4: |  |
| Pin 1, 2, or 3 referenced to earth ground: |  |
| DT8873 and DT8874 Voltage Input Channels Overvoltage Protection (Power On/Off) | 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\)  
Validity: 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\) |
| Pin 1 referenced to pin 3: |  |
| Pins 1 and 3 referenced to earth ground: |  |
| ESD protection per standard EN6100-4-2:2009 (see page 137 for more) |  |
| Arc: | 8 kV  
4 kV |
| Contact: |  |
| Isolation voltage to the host computer | 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\) |
| Channel-to-channel isolation | 30 VAC, 42.4 Vpk, 60 VDC max.\(^\text{a}\) |

\(^{a}\) These pins are functionally isolated for a maximum of 30 VAC, 60 VDC Ch-Earth, verified by a 500 Vpk withstand.
\(^{b}\) Determined by internal protection diodes to the power supply. No damage occurs if current is limited to ±10 mA.
Memory Specifications

Table 19 lists the memory specifications for the analog input subsystem on the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

Table 19: Memory Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data memory onboard</td>
<td>4 MByte</td>
</tr>
<tr>
<td>For Data logger built in, maximum time before old data is overwritten*</td>
<td></td>
</tr>
<tr>
<td>48 channels @ 10 Hz:</td>
<td>30 minutes</td>
</tr>
<tr>
<td>48 channels @ 1 Hz:</td>
<td>5 hours</td>
</tr>
<tr>
<td>48 channels @ 0.1 Hz:</td>
<td>50 hours</td>
</tr>
</tbody>
</table>

\* Assumes limit detection is off for all channels, and for thermocouple channels, assumes CJC data is not collected. If power fails, all temperature data in the system is lost. The channel input type and filter settings are still available after power on, but the channel and digital I/O labels and channel limits are lost.
**Digital I/O Specifications**

Table 20 lists the specifications for the digital input (DIN) and digital output (DOUT) subsystems on the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of digital I/O lines</td>
<td>16 (8 In, 8 Out)</td>
</tr>
<tr>
<td>Number of ports</td>
<td>2, 8-bit (1 In, 1 Out)</td>
</tr>
<tr>
<td>Inputs</td>
<td></td>
</tr>
<tr>
<td>Input type:</td>
<td>DC</td>
</tr>
<tr>
<td>High input voltage:</td>
<td>+3 to +28 V</td>
</tr>
<tr>
<td>Low input voltage:</td>
<td>&lt; +1.5 V</td>
</tr>
<tr>
<td>High input current:</td>
<td>2.2 kΩ resistor to 1.2 V</td>
</tr>
<tr>
<td>Low input current:</td>
<td>2.2 kΩ resistor to 1.2 V</td>
</tr>
<tr>
<td>Termination</td>
<td>Series 2.2 kΩ</td>
</tr>
<tr>
<td>Outputs</td>
<td></td>
</tr>
<tr>
<td>Output type:</td>
<td>Solid-state relay</td>
</tr>
<tr>
<td>Output driver:</td>
<td>CMOS</td>
</tr>
<tr>
<td>High output:</td>
<td>± 30 V</td>
</tr>
<tr>
<td>Low output:</td>
<td>0.4 V @ 400 mA</td>
</tr>
<tr>
<td>Breakdown voltage:</td>
<td>± 60 V</td>
</tr>
<tr>
<td>Contact impedance:</td>
<td>1 Ω</td>
</tr>
<tr>
<td>Isolation voltage</td>
<td></td>
</tr>
<tr>
<td>To computer ground:</td>
<td>30 VAC, 42.4 Vpk, 60 VDC max.</td>
</tr>
<tr>
<td>Channel to channel:</td>
<td>30 VAC, 42.4 Vpk, 60 VDC max.</td>
</tr>
</tbody>
</table>

a. These pins are functionally isolated for a maximum of 30 VAC, 60 VDC Ch-Earth, verified by a 500 Vpk withstand.
Power, Physical, and Environmental Specifications

Table 21 lists the power, physical, and environmental specifications for the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

Table 21: Power, Physical, and Environmental Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>External power requirements</td>
<td>+5 V ±0.25 Volt @ 2 A (0.9 mA typical)</td>
</tr>
<tr>
<td>Physical</td>
<td></td>
</tr>
<tr>
<td>Dimensions of enclosure:</td>
<td>88.14 (H) x 212.85 mm (W) x 211.43 mm (D)</td>
</tr>
<tr>
<td>Weight:</td>
<td>1704 g</td>
</tr>
<tr>
<td>Environmental</td>
<td></td>
</tr>
<tr>
<td>Operating temperature range:</td>
<td>0° C to 55° C</td>
</tr>
<tr>
<td>Storage temperature range:</td>
<td>−25° C to 85° C</td>
</tr>
<tr>
<td>Relative humidity:</td>
<td>10 to 90%, noncondensing</td>
</tr>
<tr>
<td>Altitude:</td>
<td>up to 2000 m</td>
</tr>
<tr>
<td>Pollution degree:</td>
<td>2</td>
</tr>
</tbody>
</table>

Indoor use only
The DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments are CE-compliant. Table 22 lists the regulatory specifications for the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

### Table 22: Regulatory Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emissions (EMI)</td>
<td>FCC Part 15, Class A</td>
</tr>
<tr>
<td>Immunity</td>
<td>EN 61326-1:2013 (IEC 61326-1:2012), Class A</td>
</tr>
<tr>
<td></td>
<td>EMC Requirements</td>
</tr>
<tr>
<td></td>
<td>EN61000-4-2:2009</td>
</tr>
<tr>
<td></td>
<td>Electrostatic Discharge (ESD) 4 kV contact discharge,</td>
</tr>
<tr>
<td></td>
<td>8 kV air discharge, 4 kV horizontal and vertical coupling planes</td>
</tr>
<tr>
<td></td>
<td>EN61000-4-3:2006</td>
</tr>
<tr>
<td></td>
<td>Radiated electromagnetic fields, 3 V/m, 80 to 1000 MHz;</td>
</tr>
<tr>
<td></td>
<td>3 V/m, 1.4 GHz to 2 GHz; 1 V/m, 2 GHz to 2.7 GHz</td>
</tr>
<tr>
<td></td>
<td>EN61000-4-4:2004</td>
</tr>
<tr>
<td></td>
<td>Electrical Fast Transient/Burst (EFT) 1 kV on data cables</td>
</tr>
<tr>
<td></td>
<td>EN61000-4-6:2009</td>
</tr>
<tr>
<td></td>
<td>Conducted immunity requirements, 3 Vrms on data cables</td>
</tr>
<tr>
<td></td>
<td>150 kHz to 80 MHz</td>
</tr>
<tr>
<td>RoHS (EU Directive 2011/65/EU)</td>
<td>Compliant (as of July 1st, 2006)</td>
</tr>
</tbody>
</table>
Connector Specifications

This section lists the specifications for the following connector types:

- Thermocouple connectors
- RTD connectors
- Voltage connectors
- Ethernet connector

Thermocouple Connectors

Table 23 lists the specifications for the thermocouple connectors used on the DT8871, DT8871U, and DT8874 instruments.

Table 23: Thermocouple Connector Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermocouple jacks</td>
<td>Omega plugs</td>
</tr>
<tr>
<td></td>
<td>SMPW-U-M – For voltage measurements</td>
</tr>
<tr>
<td></td>
<td>SMPW-J-M – For J thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-K-M – For K thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-T-M – For T thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-E-M – For E thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-S-M – For S thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-R-M – For R thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-B-M – For B thermocouple type</td>
</tr>
<tr>
<td></td>
<td>SMPW-N-M – For N thermocouple type</td>
</tr>
<tr>
<td>Thermocouple connector</td>
<td>Omega part# PCC-SMP-U-100-R-CE-ROHS</td>
</tr>
</tbody>
</table>

CAUTION:

When connecting inputs to the thermocouple connectors on a MEASURpoint or TEMPpoint instrument, it is highly recommended that you use only original Omega thermocouple plugs (SMPW), as connectors from other suppliers may not be equivalent mechanically.

If you use connectors from suppliers other than Omega, there is a risk that you may mechanically damage the thermocouple connectors on the MEASURpoint or TEMPpoint instrument.
RTD Connectors

Table 24 lists the specifications for the RTD connectors used on the DT8872 and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Position screw terminal block header</td>
<td>Phoenix Contact 1803293</td>
</tr>
<tr>
<td>4-Position screw terminal block plug</td>
<td>Phoenix Contact 1803594</td>
</tr>
</tbody>
</table>

Voltage Connectors

Table 25 lists the specifications for the voltage connectors used on the DT8873 and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Position screw terminal block header</td>
<td>Phoenix Contact 1803293</td>
</tr>
<tr>
<td>4-Position screw terminal block plug</td>
<td>Phoenix Contact 1803594</td>
</tr>
</tbody>
</table>

Ethernet (RJ45) Connector

The Ethernet (RJ45) connector used on the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments is shown in Figure 44.

Figure 44: Ethernet (RJ45) Connector
The pin assignments of this connector are described in Table 26:

Table 26: Ethernet Connector Pin Assignments

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TXD+</td>
<td>Transmit Data+</td>
</tr>
<tr>
<td>2</td>
<td>TXD–</td>
<td>Transmit Data–</td>
</tr>
<tr>
<td>3</td>
<td>RXD+</td>
<td>Receive Data+</td>
</tr>
<tr>
<td>4</td>
<td>EPWR+</td>
<td>Power from Switch+</td>
</tr>
<tr>
<td>5</td>
<td>EPWR+</td>
<td>Power from Switch+</td>
</tr>
<tr>
<td>6</td>
<td>RXD–</td>
<td>Receive Data–</td>
</tr>
<tr>
<td>7</td>
<td>EPWR–</td>
<td>Power from Switch–</td>
</tr>
<tr>
<td>8</td>
<td>EPWR–</td>
<td>Power from Switch–</td>
</tr>
</tbody>
</table>

Note: DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments do not support Auto-MDIX.
**External Power Supply Specifications**

*Table 27* lists the specifications for the EP361 +5 V external power supply that is used with the DT8871, DT8871U, DT8872, DT8873, and DT8874 instruments.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Total Power medical power supply (TPES22-050400 or TPEMG24-S050400-7)</td>
</tr>
<tr>
<td><strong>Input voltage</strong></td>
<td>Typical 90 - 264 V AC</td>
</tr>
<tr>
<td><strong>Input current</strong></td>
<td></td>
</tr>
<tr>
<td>TPES22-050400</td>
<td>Typical 0.38 A at 115 V AC, 0.15 A at 230 V AC</td>
</tr>
<tr>
<td>TPEMG24-S050400-7</td>
<td>Typical 0.347 A at 115 V AC, 0.215 A at 230 V AC</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>47 to 63 Hz</td>
</tr>
<tr>
<td><strong>Inrush current</strong></td>
<td></td>
</tr>
<tr>
<td>TPES22-050400</td>
<td>35 A at 230 V AC typical or less than 30 A by adding thermistor</td>
</tr>
<tr>
<td>TPEMG24-S050400-7</td>
<td>6.274 A RMS at 230 V AC</td>
</tr>
<tr>
<td><strong>Output voltage</strong></td>
<td>5 V DC</td>
</tr>
<tr>
<td><strong>Output current</strong></td>
<td>4.0 A</td>
</tr>
<tr>
<td><strong>Output wattage</strong></td>
<td></td>
</tr>
<tr>
<td>TPES22-050400</td>
<td>Typical 22 - 24 W</td>
</tr>
<tr>
<td>TPEMG24-S050400-7</td>
<td>Typical 20 - 24 W</td>
</tr>
<tr>
<td><strong>Noise and ripple</strong></td>
<td>1% peak to peak</td>
</tr>
<tr>
<td><strong>Regulatory specifications</strong></td>
<td></td>
</tr>
<tr>
<td>TPES22-050400</td>
<td>UL, N, CE, FCC Class B</td>
</tr>
<tr>
<td>TPEMG24-S050400-7</td>
<td>UL, ITE, CE, FCC Class B, Energy Star compliant</td>
</tr>
</tbody>
</table>
Connector Pin Assignments
Table 28 lists the pin assignments for the 37-pin digital I/O connector on TEMPpoint, VOLTpoint, and MEASURpoint instruments.

**Table 28: Digital I/O Connector Pin Assignments**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Digital Input 0+</td>
<td>20</td>
<td>Digital Input 0–</td>
</tr>
<tr>
<td>2</td>
<td>Digital Input 1+</td>
<td>21</td>
<td>Digital Input 1–</td>
</tr>
<tr>
<td>3</td>
<td>Digital Input 2+</td>
<td>22</td>
<td>Digital Input 2–</td>
</tr>
<tr>
<td>4</td>
<td>Digital Input 3+</td>
<td>23</td>
<td>Digital Input 3–</td>
</tr>
<tr>
<td>5</td>
<td>Digital Input 4+</td>
<td>24</td>
<td>Digital Input 4–</td>
</tr>
<tr>
<td>6</td>
<td>Digital Input 5+</td>
<td>25</td>
<td>Digital Input 5–</td>
</tr>
<tr>
<td>7</td>
<td>Digital Input 6+</td>
<td>26</td>
<td>Digital Input 6–</td>
</tr>
<tr>
<td>8</td>
<td>Digital Input 7+</td>
<td>27</td>
<td>Digital Input 7–</td>
</tr>
<tr>
<td>9</td>
<td>Not Connected</td>
<td>28</td>
<td>Not Connected</td>
</tr>
<tr>
<td>10</td>
<td>Digital Output 0</td>
<td>29</td>
<td>Digital Output 0</td>
</tr>
<tr>
<td>11</td>
<td>Digital Output 1</td>
<td>30</td>
<td>Digital Output 1</td>
</tr>
<tr>
<td>12</td>
<td>Digital Output 2</td>
<td>31</td>
<td>Digital Output 2</td>
</tr>
<tr>
<td>13</td>
<td>Digital Output 3</td>
<td>32</td>
<td>Digital Output 3</td>
</tr>
<tr>
<td>14</td>
<td>Digital Output 4</td>
<td>33</td>
<td>Digital Output 4</td>
</tr>
<tr>
<td>15</td>
<td>Digital Output 5</td>
<td>34</td>
<td>Digital Output 5</td>
</tr>
<tr>
<td>16</td>
<td>Digital Output 6</td>
<td>35</td>
<td>Digital Output 6</td>
</tr>
<tr>
<td>17</td>
<td>Digital Output 7</td>
<td>36</td>
<td>Digital Output 7</td>
</tr>
<tr>
<td>18</td>
<td>Not Connected</td>
<td>37</td>
<td>Not Connected</td>
</tr>
<tr>
<td>19</td>
<td>Not Connected</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring Network Settings on Your PC

Configuring the PC to Use Auto-IP .................................................. 146
Specifying a Static IP Address for your Instrument ............................... 149
Reconfiguring the PC to Use a Static IP Address ................................. 150
Configuring the PC to Use Auto-IP

To set up the a TEMPpoint, VOLTpoint, or MEASURpoint instrument when the LAN does not support a DHCP server and your PC is configured to use a static IP address, you must temporarily reconfigure the PC to use Auto-IP by performing the following steps:

Note: This procedure may differ slightly depending on your computer and the version of Windows you are using. Windows XP instructions are shown here.

1. From the Windows Start menu, click Settings, and then click Network Connections.
2. Right-click Local Area Connection, and select Properties.
3. In the General tab window, double-click Internet protocol (TCP/IP). (If a TCP/IP selection is not listed, click Install, select Protocol, click Add, select the TCP/IP protocol, and click Install, and repeat step 3).
4. IMPORTANT: Write down the IP address and subnet mask that is displayed! You will need this information later.

5. Select Obtain an IP address automatically, and then click OK.

6. Select the Alternate Configuration tab, and ensure that Automatic private IP address is selected.
7. Renew the IP address of the computer. From the Windows Start menu, click **Settings** -> **Network Connections** -> **Local Area Connection** -> **Support** -> **Repair**.

Or, if you prefer to do this from the command prompt window, click **Run** from the Windows Start menu, enter **cmd**, and click **OK** to bring up the command prompt window. Then, from the command prompt window, enter:

```
ipconfig /renew  
renews the IP address

ipconfig /all  
checks the IP address
```
Specifying a Static IP Address for your Instrument

To specify a static IP address for your TEMPpoint, VOLTpoint, or MEASURpoint instrument, use the LAN Configuration page of the web interface as follows:

1. From the LAN Configuration page, click Modify.
2. Specify the username as sysadmin, and specify the password (the default password is user). You can change the password, if you desire.
3. Uncheck the checkbox called Automatic private IP address enabled.
4. Click Static.
5. Specify a static IP address for the instrument, so that is will be on the same subnet as your PC:

![LAN Configuration screenshot]

Note: You need a Simple Network Time Protocol (SNTP) time server on the LAN; otherwise, you need to provide a gateway. See your network administrator for more details.
Reconfiguring the PC to Use a Static IP Address

After you have set up your instrument, you can reconfigure your PC to use a static IP address using this procedure:

1. From the Windows Start menu, click Settings, and then click Network Connections.
2. Right-click Local Area Connection, and select Properties.
3. In the General tab window, double-click Internet protocol (TCP/IP).
4. Select Use the following IP address, specify the static IP address and subnet mask that was initially assigned to the PC (see page 146), and click OK.

5. Renew the IP address of the computer. From the Windows Start menu, click Settings -> Network Connections -> Local Area Connection -> Support -> Repair.

   Or, if you prefer to do this from the command prompt window, click Run from the Windows Start menu, enter cmd, and click OK to bring up the command prompt window. Then, from the command prompt window, enter:

   ipconfig /renew   renews the IP address
   ipconfig /all     checks the IP address
A
accessories 22
accuracy specifications, thermocouple 124, 126
Active Scripting 70
activity, Ethernet LED 42
address string 41
Agilent VISA 31
alarm limit configuration 84
alias, VISA 41
alpha curves 128
analog input 101
  basic instrument specifications 122
  calibration 106
  channels 101
CJC circuit 103
configuration 80
conversion modes 108
data format for RTD channels 110
data format for thermocouple channels 110
data format for voltage channels 111
differential configuration 49, 51
error conditions 111
filtering 110
input ranges 104
open thermocouple detection 103
out of range data 105, 106
resolution 106
RTD specifications 128
RTD types 104
sample clock 107
thermocouple specifications 123
thermocouple types 102
trigger source 107
wiring current loop inputs to RTD channels 62
wiring current loop inputs to thermocouple channels 60
wiring current loop inputs to voltage channels 63
wiring RTD inputs 51
wiring thermocouple inputs 49
wiring voltage inputs to RTD channels 57
wiring voltage inputs to thermocouple channels 55
wiring voltage inputs to voltage channels 58
application wiring
  current loop inputs to RTD channels 62
  current loop inputs to thermocouple channels 60
  current loop inputs to voltage channels 63
digital inputs 65
digital outputs 66
RTD inputs 51
thermocouple inputs 49
voltage inputs to RTD channels 57
voltage inputs to thermocouple channels 55
voltage inputs to voltage channels 58
applying power 39
associating CSV files 74
attaching the module to the computer 35
Auto-IP 37, 41, 146

B
block diagrams 96
  DT8871 97
  DT8871U 96
  DT8872 98
  DT8873 99
  DT8874 100

cables 36
  crossover 38
  standard LAN (EP372) 37
calibration 106
channel-to-channel functional isolation 113
CJC circuit 103
clients 69
clocks, analog input 107
cold junction compensation 103
configuring
  alarm limits 84
  analog input channels 80
digital inputs 85
digital outputs 86
  filters 83
  LAN 79
  scan rate 82
  triggers 85
configuring network settings on PC 145
connecting signals
  current loop inputs to RTD channels 62
  current loop inputs to thermocouple channels 60
  current loop inputs to voltage channels 63
Index

digital inputs 65
digital outputs 66
RTD inputs 51
thermocouple inputs 49
voltage inputs to RTD channels 57
voltage inputs to thermocouple channels 55
voltage inputs to voltage channels 58
connecting to the LAN 35
private LAN 37
site LAN 36
connector pin assignments
digital I/O connector 143
Ethernet connector 140
continuous analog input 108
conversion modes 108
continuous analog input (scan mode) 108
digital I/O 113
simultaneous single-value analog input 108
conversion rate 109
crossover cable 38
CSV files 74
customer service 119

d data encoding 110
data format
   RTD channels 110
   thermocouple channels 110
   voltage channels 111
DHCP server 36, 37, 41
differential channels 49, 51
digital I/O
   channel-to-channel functional isolation 113
   connecting input signals 65
   connecting output signals 66
   connector pin assignments 143
   controlling the outputs 88
   input configuration 85
   lines 112, 113
   operation modes 113
   output configuration 86
   reading the digital input port in the analog data stream 108
   reading the inputs 90
   resolution 113
   specifications 135
   subsystem specifications 135
digital trigger 107
discovery utility, Eureka 19, 31, 75
DNS server 41
downloading measurements 91

E encoding data 110
ENet Activity LED 42
ENet Link LED 42
environmental specifications 136
EP333 cable assembly 22, 64
EP372 LAN cable 37
EP373 single rack mount kit 22
EP374 dual rack mount kit 22
error conditions 111
Ethernet activity 42
Ethernet cable 36, 37
Ethernet connector specifications 139
Ethernet crossover cable 38
Eureka Discovery Utility 19, 31
   firewall settings 76
   running 75
   troubleshooting 76
   using 75
Excel 74
   using to display data 92
external digital trigger 107

F factory service 119
features 14
FIFO 109
filters 83, 110
floating-point data 110
formatting data
   RTD channels 110
   thermocouple channels 110
   voltage channels 111
frequency 107

G GMT 80

H hardware features 14
high drive digital outputs 66
host name 41
hub
   using with a private LAN 37
   using with a site LAN 36
Index

I
input ranges 104
installing the software 31
prerequisites 31
instrument web interface 19
Internet Explorer browser settings 69
JavaScript 70
pop-up blockers 73
security levels 70
Internet zone 70
Intranet zone 71
IP address 41
isolation 113
isolation specifications 133
IVI-COM driver 21

J
Java 69

L
LAN
configuration 79
connecting to a private LAN 37
connecting to a site LAN 36
LED 42
launching the web interface 78
LEDs
ENet Activity 42
ENet Link 42
LAN 42
LMT 42, 105, 106
OPN 42, 103, 105
Power 39
USB 42
limit configuration 84
lines, digital I/O 112, 113
LMT LED 42, 105, 106

M
Measurement Instrument Calibration Utility 21
mechanical relays, controlling 66
memory specifications 134
Microsoft Excel 74
Microsoft Notepad 74
moving average filter 110

N
network settings 145
NI-VISA 31
Notepad 74

O
open thermocouple detection 103
operation modes
continuous analog input (scan mode) 108
digital I/O 113
simultaneous single-value analog input 108
OPN LED 42, 103, 105
opto-isolators 112
out of range data
RTD channels 106
thermocouple channels 105
voltage channels 106

P
password 80
physical specifications 136
pinging the instrument 116, 117
pop-up blockers 73
power
applying 39
specifications 136
prerequisite software 31
private LAN 37
connecting directly to a computer 38
connecting using a hub or switch 37
protection specifications 133

Q
QuickDAQ
Advanced FFT Analysis option 20
Base version 19
FFT Analysis option 20

R
rack mounting 22
raw filter 110
recommendations for wiring 47
regulatory specifications 137
requirements 30
requirements for web interface 69
associating CSV files 74
Internet Explorer browser settings 69
Java 69
Reset pin 42, 44
resetting the instrument 44
resolution
  analog input 106
digital I/O 113
returning boards to the factory 119
RJ45 connector specifications 139
RMA 119
router, using with a site LAN 36
RTD alpha curves 128
RTD channels
  data format 110
RTD connections
  2-wire 53
  3-wire 53
  4-wire 52
RTD connector specifications 139
RTD specifications 128
RTD types 104

S
sample clock 107
sample rate 109
scan rate 82
SCPI
  clients 69
  programming 21
security levels 70
  Internet zone 70
  Intranet zone 71
  Trusted Site zone 72
SENSOR_IS_OPEN 104
simultaneous single-value analog input 108
site LAN 36
  connecting using a hub, switch, or router 36
  connecting without using a hub, switch, or router 37
software trigger 107
solid-state relays 113
  controlling 66
sourcing 66
specifications 121, 145
  basic instrument 122
digital I/O 135
environmental 136
Ethernet connector 139
external power supply 141
isolation and protection 133
memory 134
physical 136
power 136
regulatory 137
RJ45 connector 139
RTD 128
RTD connectors 139
system temperature error 124, 126
temperature 129
thermocouple 123
thermocouple connectors 138
voltage connectors 139
voltage measurement 131
static IP addresses 80, 146, 150
STP37 screw terminal panel 22, 64
switch
  using with a private LAN 37
  using with a site LAN 36
system requirements 30
system temperature error 124, 126

T
TCP/IP configuration 41
technical support 118
temperature error 124, 126
temperature specifications 129
thermocouple accuracy specifications 124, 126
thermocouple channels
  data format 110
thermocouple connector specifications 138
thermocouple types 102
trademark and copyright information 2
trigger source 107
  external 107
  software 107
triggers 85
troubleshooting
  procedure 116
technical support 118
troubleshooting table 116
  Trusted Site zone 72

U
unpacking 29
USB LED 42
username 80
UTC 80
V
VISA alias 41
VISA resource string 41
voltage connector specifications 139
voltage measurement specifications 131
VXI-11 clients 69

W
warm-up time 48
web interface 19, 78
  alarm limit configuration 84
  analog input channel configuration 80
  clients 69
  controlling the digital outputs 88
  digital input and trigger configuration 85
  digital output configuration 86
  downloading measurements 91
  filter configuration 83
  LAN configuration 79
  measurement and controlling the instrument 87
  reading the digital inputs 90
  requirements for using 69
  scan rate configuration 82
  starting and stopping a scan 87
wiring signals
  current loop inputs to RTD channels 62
  current loop inputs to thermocouple channels 60
  current loop inputs to voltage channels 63
  digital inputs 65
  digital outputs 66
  recommendations 47
  RTD inputs 51
  thermocouple inputs 49
  voltage inputs to RTD channels 57
  voltage inputs to thermocouple channels 55
  voltage inputs to voltage channels 58
  warm-up time 48

Z
zones
  Internet 70
  Intranet 71
  Trusted Site 72